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Document History

The following table provides an overview on the most important document changes:

Caution

Before you start the implementation, make sure that you have the latest version of this document. You can find
the latest version at http://help.sap.com/nw731 | Installation and Upgrade 3.
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Version Date Description

1.0 2010-11-29 Initial Version

11 2010-12-06 Minor changes

1.2 2011-03-09 Minor changes

1.3 2011-11-12 Text and Structure of Master Guide re-
vised
Information about SAP enhancement
package 1 for NetWeaver 7.3 added

1.4 2012-02-03 Information about SAP enhancement
package 1 for NetWeaver 7.3 updated

15 2012-05-14 Minor changes

1.6 2012-06-25 Information about SAP NetWeaver Busi-
ness Warehouse 7.3, powered by SAP
HANA, added
Information regarding SAP Solution
Manager updated

1.7 2012-08-07 Information about System Copy and Mi-
gration added
SAPinst tool replaced by software provi-
sioning manager 1.0

1.8 2013-01-23 Minor changes

19 2013-06-06 Minor changes and updates, and
changes in guide structure
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1 Getting Started

11 About this Document

This Master Guide is the central starting point for the technical implementation of the technology platforms

e SAP NetWeaver 7.3
e SAP enhancement package 1 for SAP NetWeaver 7.3

1 Note

For reasons of readability, we use In this guide for the above-mentioned platforms the name SAP NetWeaver
7.3 including enhancement package 1 or the abbreviation SAP NetWeaver 7.3 incl. EHP 1. In some cases, we also
use SAP NetWeaver 7.31 short for SAP enhancement package 1 for SAP NetWeaver 7.3.

This guide provides you with information about the use cases as well as the installable product instances, and
refers you to the detailed documentation (such as the Installation Guides).
Caution

The Master Guide is regularly updated. Make sure that you have the latest version by checking http://
help.sap.com/nw731 |l Installation and Upgrade 3 immediately before starting the installation.

Constraints

The scenarios that are presented here serve as examples of how you can use SAP software in your company. The
scenarios are intended only as models and do not necessarily run the way they are described here in your
customer-specific system landscape. Check your requirements and systems to determine whether these
scenarios can be used productively at your site. Furthermore, we recommend that you test these scenarios
thoroughly in your test systems to ensure that they are complete and free of errors before going live.

See also

The upgrade or update to SAP NetWeaver 7.3 including enhancement package 1 is described in the document
Upgrade Master Guide — SAP NetWeaver 7.3 incl. Enhancement Package 1. The Upgrade Master Guide is available

at http://help.sap.com/nw731 |l Installation and Upgrade 3.

1.2 Glossary

Short overview of some technical terms as well as SAP NetWeaver key terms:

1 Note

Usage Type, Technical Usage, and Product Instance

SAP NetWeaver Master Guide
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The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.31 and higher. For more information, see SAP Note 1877731# . Note that there is no
terminology change for older releases and all mentioned terms can be used as synonyms.

Table 2:

Term

Client

Explanation

Clients are additional installable programs or tools. They reside either on local front-end PCs
accessed by users or on back-end systems where they act as client programs within an SAP
NetWeaver system landscape.

Functional Unit

A configured and activated unit of SAP NetWeaver that provides a set of functions, allowing
the implementation and execution of activities such as process steps within IT scenarios. It is
nestable and can be grouped into larger functional units. Examples include transport manage-
ment system, system landscape directory, adapter framework, and business process engine.

Landscape Pattern

Defines if a technical system is used by one or several product systems to calculate update
and upgrade methods. The landscape pattern can be defined as “hub” system (if used by sev-
eral product systems) or as “sidecar” system (if used by one product system).

LMDB

Landscape Management Database

Central storage and editor for system information in SAP Solution Manager, supplied by a
central SLD. In the LMDB, you manage technical information (such as technical systems and
hosts) and logical information (such as product systems and technical scenarios). This data
is the basis for other applications, like monitoring and alerting, diagnostics, maintenance
transactions, and SAP Support Portal.

As of SAP Solution Manager 7.1, the LMDB replaces the previous information storage SMSY.

Logical Component

Group of technical systems that provide a concrete business function by installed product in-
stances and by different roles (such as development, test or production system).

Maintenance Optimizer
(MOpz)

Application within SAP Solution Manager that guides you through planning and downloading
stack XML files for enhancement packages, support packages, and additional update pack-
ages. These files can be used as input files for the installation by update tools like Software
Update Manager.

Product

An SAP offering in the SAP price list that performs business tasks.

The complete product model is shipped as SAP Software Catalog. The availability of products
is published in the Product Availability Matrix (PAM). The product model defines the product
structure with its product instances, software components, version, and technical dependen-
cies between product and its components. Products typically have a name starting with
'SAP..." and are characterized by a version period and a maintenance cycle. A product can be
installed on one or more technical systems. All technical systems that are involved form the
product system.

Examples for products are SAP ERP, SAP NetWeaver, and SAP Solution Manager.

SAP NetWeaver Master Guide
Getting Started
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Term

Product Instance

Explanation

Part of a product version that bundles one or more software components.

A product instance is part of only one product version. It must be installed and updated as a
whole on a single technical system. (ABAP-Java dual-stacks are considered one technical
system.) Patches can still be installed for individual software components. A product instance
can contain other product instances. It can be re-used across products.

Examples for product instances are SAP ECC Server and SAP NetWeaver AS ABAP.

Product System

A group of technical systems on which a product version is installed. Product system descrip-
tions are used to maintain and plan products in the system landscape.

Product Version

A release of an SAP product.

It bundles product instances and the included software component versions that are available
at a particular time for a specific scope of functionality. Like products, product versions are
shipped in the SAP Software Catalog. They are the basis for the compatibility of closely cou-
pled systems and the maintenance of product systems.

An example is SAP ERP 6.0, which is a product version of the product SAP ERP.

Optional Standalone Units

Optional standalone units are additional software units that you install separately. They are
based on Application Server Java (AS Java) and provide specific (server) functions in combi-
nation with one or more SAP systems.

SLD

System Landscape Directory

Central provider of information on technical systems, for consumers in the system landscape
and for external consumers. The SLD gets its information mainly from SLD data suppliers,
which are installed on the technical systems, and from the SAP software catalog.

With the SLD, you collect and edit system data that is required for system landscape manage-
ment. This information can be used by other consumers, such as SAP NetWeaver Process In-
tegration, WebDynpro for Java, and SAP Solution Manager.

SMSY

The SAP Solution Manager System Landscape collects information about the SAP systems in
the landscape. (SMSY is the name of the transaction in SAP Solution Manager.) As of SAP
Solution Manager 7.1, the new information storage LMDB replaces SMSY.

Software Component

Delivery and product unit of an SAP software product

A software component comprises a set of packages that are delivered in a single unit. You al-
ways assign repository objects to a software component by assigning the package containing
these objects. This makes it possible to move repository objects from one software compo-

nent to another during a release upgrade. A software component is released in successive re-
leases with new functions. You can import patches into each software component separately.

Software Provisioning Man-

A tool that performs software provisioning processes such as installation, uninstallation, sys-

ager tem copy, or system transformation. The Software Provisioning Manager is delivered with the
Software Logistics Toolset.
SAP NetWeaver Master Guide
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Term

Stack configuration file

Explanation

The stack configuration file is created by the Maintenance Optimizer and is system-specific.
Depending on the software components that are installed in a system, the Maintenance Opti-
mizer calculates the required software components that have to be updated to reach a cer-
tain target configuration.

Standalone Engine

Standalone engines of SAP NetWeaver are additional installable software units. They do not
work as full-blown systems of SAP NetWeaver, but as standalone engines that provide a spe-
cific (server) function in combination with one or more SAP NetWeaver systems. Standalone
engines are not part of a usage type. They do not run on AS ABAP or AS Java.

Technical System

Describes a part of a product's software that is installed on one or several physical or virtual
hosts.

A technical system is installed and administered as a whole. It is identified by a system ID
(SID) or extended SID, a host, and an installation number. There are different technical sys-
tem types, for example Application Server (AS) ABAP, AS Java, or TREX. Technical systems
are central elements when it comes to software component deployment and operational ac-
tivities, such as monitoring and alerting.

Update

Activities to maintain or enhance a system, such as installing enhancement packages, instal-
ling add-ons, or applying Support Package stacks or Support Packages.

Note: The tool for system maintenance tasks is the Software Update Manager (SUM). In the
SUM guide, the term "Update" is used as collective term for all the tasks that can be per-
formed using this tool (such as performing release upgrades, installing enhancement pack-
ages, or updating a system with Support Package Stacks).

Upgrade

The switch from an older software version to a new version. Typically, both the server compo-
nent of a system landscape and other components are upgraded. Several different technical
upgrade procedures are used to upgrade the server component, such as the Repository
Switch upgrade or the System Switch upgrade.

Usage Type

An installed and correspondingly configured part of an SAP NetWeaver system that provides
key capabilities for a system landscape. It specifies the intended purpose of a system, and it is
the result of the configuration of the underlying installed software units and the configuration
of the underlying functional units.

Examples include business intelligence, process integration, and enterprise portal.

Use Case

A definition of use from the end users' perspective for accomplishing a specific goal within a
system. Use cases represent the main capabilities of the system to fulfill specific require-
ments.

SAP NetWeaver Master Guide
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1.3 SAP NetWeaver Use Cases

Use

The use cases illustrate how you can use your SAP NetWeaver implementation. The main use cases of SAP
NetWeaver and their corresponding key areas of SAP NetWeaver are as follows:

Table 3:
Use Case Corresponding Key Area of SAP NetWeaver
Building Composite Applications SAP NetWeaver Composition Environment
Data Warehousing SAP NetWeaver Business Warehouse
Building Integration Scenarios SAP NetWeaver Process Integration

Integrating and Self Servicing Content with SAP NetWeaver SAP NetWeaver Portal

Portal
Mobilizing Business Processes SAP NetWeaver Mobile
Custom Application Development (ABAP) (All areas that allow ABAP development on the Application
Server ABAP)
Constraints

For SAP enhancement package 1 for SAP NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on. For
more information see SAP Note 1645275 .

More Information

You can get all information about the key areas with regard to SAP NetWeaver 7.3 including enhancement
package 1inthe SAP Help Portal and in the SAP Community Network (SCN) as follows:

e SAP Help Portal
SAP Help Portal bundles access to SAP product documentation and also related information, such as SAP
Notes, product availability information, as well as community content.
For SAP NetWeaver 7.3, access the Help Portal using the address http://help.sap.com/nw73#%, and for SAP
enhancement package 1 for SAP NetWeaver 7.3, use the address http://help.sap.com/nw731 % .

1. Choose ||r Application Help » <key area> 3 for instructions for using the application.

2. Choose |l Application Help » Function-Oriented View » <functional area> 3 for a component-based
reference of all functions and tasks that can be performed with the product.

e SAP Community Network (SCN)

SAP NetWeaver Master Guide
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The SCN is organized into more than 300 “spaces”, which support small, self-contained communities. These
communities are typically focused around a topic, an SAP product, or an industry. Each space contains a
complete set of social networking tools including a discussion forum, a blogging area, and an area where you

can publish and collaborate on documents.

As alogged-on member, you can go to any space in the SCN landscape but it's likely that you will be
interested in visiting and following a particular set of spaces that reflect your particular range of interests and
where members who share your interests are likely to hang out.

SCN spaces are where you get the latest news from SAP and the community, where you interact with your
peers, where you earn points for your contributions, and where you establish reputation as being expert on

certain topics

You access the SCN using the address http://scn.sap.com .

1. Tolearn more about SAP NetWeaver, choose .

o |k Products ¥ tab “Technology” # Application Foundation/Integration » SAP NetWeaver » SAP

NetWeaver 3 or

o |» Lines of Business ¥ Information Technology & SAP NetWeaver 3
2. Moreover, the SAP Community Network provides you with detailed information regarding the SAP

NetWeaver use cases:
Table 4:

For the use case

Integrating and Self Servicing Content with SAP NetWeaver
Portal

choose in the SCN Community:

|» Products # tab “Technology” > Application Foundation/
Integration > SAP NetWeaver > Team Productivity > SAP
Enterprise Portal ]

or choose http://scn.sap.com/community/enterprise-portal

i

Data Warehousing

|+ Products i tab “Technology” » Application Foundation/
Integration > SAP NetWeaver > Information Management >
SAP Business Warehouse }

or choose http://scn.sap.com/community/data-warehous-
ing/bw e

Building Composite Applications

|} Products > tab “Technology” > Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >

Business Process Management ]

or choose http://scn.sap.com/community/bpm

Custom Application Development

|} Products > tab “Technology” > Application Foundation/
Integration > Custom Development > ABAP Development >
ABAP Development }

or choose http://scn.sap.com/community/abap

SAP NetWeaver Master Guide
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For the use case choose in the SCN Community:

Mobilizing Business Processes | Products # tab “Technology” ¥ Enterprise Mobility
Enterprise Mobility |

or choose http://scn.sap.com/community/mobile i

Building Integration Scenarios | Products # tab “Technology” ¥ Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >
Process Integration & SOA Middleware ]

or choose http://scn.sap.com/community/pi-and-soa-mid-
dleware P

1.4 Business View of the Use Cases

For implementation and configuration purposes, the SAP NetWeaver use cases are structured according to the
business view of SAP's Software Portfolio. This portfolio is structured using elements such as

e Solutions

e Solution Editions

e Key Capabilities / Scenario Groups
e Scenarios/Processes

Various tools, services and processes use the business view of the SAP Software Portfolio such as the Business
Process Repository for the SAP Solution Manager.

The following table displays the structured business view of the use cases in the SAP Solution Manager:
Table 5:

Use Case Corresponds to Business Scenario Includes the Scenarios/Processes

Group/Key Capability

Building Composite Applications Building Composite Applications ® Business Rules Management
e Java Development and SOA Infra-
structure

® Process Composition

Data Warehousing Enterprise Data Warehousing e Data Modelling

e Define Data Flow

e Metadata Management

e Performance Optimization

e Scheduling and Monitoring

SAP NetWeaver Master Guide
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Use Case

Corresponds to Business Scenario

Group/Key Capability

Includes the Scenarios/Processes

Building Integration Scenarios

Building integration-centric processes

Building integration-centric processes
using the single-SID Pl and BPMs

Integrating and Self Servicing Content
with SAP NetWeaver Portal

Integrating and Self Servicing Content
with SAP NetWeaver

Building Communities with Wikis &
Forums

Content Management Scenarios
with Knowledge Management
Managing and mashing up portal
pages with Web Page Composer
Portal Landscape Interoperability
and Openness

Unified Access to Applications and
Processes

Mobilizing Business Processes

Mobilizing Business Processes

Developing Mobile Applications for
Occasional Connection

Enabling Mobile Applications for Oc-
casional Connection

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

1.5 Mapping of Use Cases to Installable Software Units

To give you a quick overview of SAP NetWeaver 7.3 including enhancement package 1, the table below shows the
mapping between use cases and required SAP NetWeaver software units. For details about the software units,
see section Description of Software Units [page 55].

SAP NetWeaver Master Guide
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Table 6:

Use Case Product Instance Standalone Engines Optional Standalone Clients

Units

Building Composite Ap-
plications: [page 22]

Business Rules
Management and
Process Composition

AS Java

Adobe Document
Services (optional)
Business Process
Management and
Business Rule
Management
Composite Appli-
cation Framework
Composition Envi-
ronment Platform

Developer Work-
place

SAP NetWeaver
Developer Studio
Visual Composer
Adobe LiveCycle
Designer (Op-
tional)

Web Browser

SOA Infrastructure

Enterprise Serv-
ices Repository

NW Product De-
scription
DI [optional]
Building Composite Ap- AS Java Developer Work-
plications: [page 22] NW Product De- place
Java Development and scription SAP NetWeaver.
DI [optional] Developer Studio

Web Browser

Data Warehousing AS ABAP Search and Classifica- SAP GUI with BW
[page 36] BW ABAP tion (TREX) Add-On/BI Add-
AS Java On
NW Product De- SAP BusinessOb-
scription [optional] jects Advanced
AS Java Exten- Analyss, Edition
sions [optional] for Microsoft Of-
fice* [optional
Bl Java [optional] ice* [optional]
SAP Busi Ob-
EP Core - Applica- . usiness
i jects Crystal Re-
tion Portal [op- _
tional] ports* [optional]
AP Busi -
Enterprise Portal S u5|n§ssOb
i jects Xcelsius [op-
[optional] .
tional]
SAP BusinessOb-
jects Web Intelli-
gence* [optional]
SAP NetWeaver Master Guide
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Use Case Product Instance Standalone Engines Optional Standalone Clients
Units
Building Integration e Application Server | ® Adapter Engine e Advanced Adapter
Scenarios [page 30] Java (Java SE) [op- Engine [optional]
e NW Product De- tional] e Advanced Adapter
scription Engine Extended
e AS Java Exten-
sions

e Application Server
ABAP

® Process Integra-
tion

e Enterprise Serv-
ices Repository

® Process Integra-

tion Adapter En-
gine
Integrating and Self e ASJava
Servicing Content with | NW Product De-
SAP NetWeaver Portal scription
[page 40] e AS Java Exten-
sions

e EP Core - Applica-

tion Portal
e EP
e Portal Add-on (for
Building
Communities with
Wikis and Forums
only)
Mobilizing Business e ASABAP e SAPGUI
Processes: [page 38] e Mobile e SAP NetWeaver
Developing Mobile Ap- | ® APplication Server Developer Studio
plications for Occa- Java * Mobile Client
sional Connectivity e DI

e EP Core — Applica-
tion Portal [op-
tional]

SAP NetWeaver Master Guide
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Use Case Product Instance Standalone Engines Optional Standalone Clients

Units
Mobilizing Business e ASABAP e SAPGUI
Processes: [page 38] e Mobile e SAP NetWeaver
Enabling Mobile Appli- | ® Application Server Developer Studio
cations for Occasional Java * Mobile Client
Connectivity e DI

e FEP Core - Applica-
tion Portal [op-

tional]
Custom Application ® Application Server e SAPGUI
Development [page ABAP

41]

*Note that SAP BusinessObjects products require separate licenses.

1.6 Enhancement Packages

1.6.1 Enhancement Package Concept

We have adapted our major release strategy to better fit your adoption cycle. To ensure that you benefit from new
developments and innovations while minimizing the impact on your core operational systems, SAP uses
enhancement packages to speed up the delivery of new functions.

With SAP enhancement packages, you can install and activate new functions depending on your business needs
without having to perform a system upgrade.

You can selectively implement the new functions and activate the software upon business demand. As a result,
you can isolate the impact of software updates and make new functions available faster due to shortened test
cycles.

Implementation

There are three different scenarios to implement an enhancement package:

e |nstallation of an enhancement package on an existing SAP system
e New installation of an SAP system including an enhancement package
e Upgrade of an SAP system including an enhancement package

SAP NetWeaver Master Guide
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Maintenance

SAP enhancement packages have Support Packages of their own that are equivalent to the Support Package
versions of the underlying SAP system. We highly recommend installing the enhancement package in
combination with the latest available Support Package stack. This approach reduces installation, modification
adjustment, and testing effort. Using this strategy, you can install SAP enhancement packages as a normal
maintenance activity together with Support Package stacks.

An enhancement package requires a specific Support Package stack level in the source release SAP system.

1 Note

If the SAP system is on a lower Support Package stack level, all relevant Support Package stacks for the
enhancement package installation are automatically included into the download queue by the Maintenance
Optimizer, as well as the latest available Support Packages for the enhancement package.

For a better understanding of the general concepts and principles of updating a system, see the Maintenance
Planning Guide at http://support.sap.com/mopz#& | section “Guides" 3

Tools

The enhancement package installation requires the following tools:

1. SAP Solution Manager

1 Note

Use of SAP Solution Manager is mandatory.

Tool versions:

We recommend to always use the latest version of the SAP Solution Manager. For more information, see SAP

Support Portal at http://support.sap.com/solutionmanager ¥
System Landscape Maintenance with SAP Solution Manager:

Make sure that you have correctly defined and maintained your system landscape in SAP Solution Manager:

o SAP Solution Manager 7.0: Use the SAP Solution Manager System Landscape (transaction sMsy) for the

complete system description.

o SAP Solution Manager 7.1 SPO1 to SP04, use the Landscape Management Database (transaction LMDB)
to maintain technical system information. For logical product system information, use transaction smMsy.

o SAP Solution Manager 7.1 SPO5 and higher, use the Landscape Management Database (transaction
LMDB) for the complete system description. (The transaction sMSY is no longer required.)

For more information about the Landscape Management Database (LMDB), see http://help.sap.com/
solutionmanager71#|» Application Help » SAP Library SAP Solution Manager 7.1 <SP version> » SAP

Solution Manager Operations ¥ Landscape Management Database (LMDB) » Managing System Landscape

Information 3.

SAP NetWeaver Master Guide
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2.

Landscape Verification with SAP Solution Manager:
To verify and correct your system landscape, SAP highly recommends that you use the verification functions
of the SAP Solution Manager:

= Recommendation

Before installing the enhancement package, we recommend that you run a landscape verification to check
your landscape setup and your system descriptions, and to correct data if necessary.

o

SAP Solution Manager 7.0 to 7.1 SP0O4: Use Landscape Verification 1.0 for SAP Solution Manager. This
add-on allows you to identify and correct issues in your SAP Solution Manager landscape (transaction
SMSY) before they cause problems, for example during a system update. Examples for errors are a
missing connection to the System Landscape Directory or the wrong assignment of products to technical
systems. For each type of error, a generic description for the solution is provided.

SAP Solution Manager 7.1 SPO5 or higher: Use the landscape verification function that is embedded into
the product system editor of the Landscape Management Database (LMDB). It replaces the previous
Landscape Verification tool.

For more information about the landscape verification, see the SAP Community Network athttp://
scn.sap.com/docs/DOC-8793 %
Installation or upgrade tools (depending on your scenario)

o

SAP Solution Manager Maintenance Optimizer (MOpz)

The SAP Solution Manager Maintenance Optimizer (MOpz) (accessible from the Change Management
work center) supports the download of a consistent queue that includes all necessary Support Packages
and enhancement packages. In addition, SAP Solution Manager calculates a valid import queue for the
selected SAP system and generates the enhancement package stack configuration file that you require
for the installation.

Software Provisioning Manager 1.0

For the new installation of an SAP system including an enhancement package you use the standard
installation tool software provisioning manager 1.0.

Software Update Manager (SUM)

To install an enhancement package on an existing SAP system, as well as for the upgrade of an SAP
system to a higher release including an enhancement package, you use the Software Update Manager
(SUM).

1.6.2 Key Facts About Enhancement Packages

The following list summarizes important facts about the enhancement package concept and recommended
approaches:

18

Install only selected parts of the enhancement package. The selection is driven by the functional need from a
business point of view.

You cannot mix the installation of different enhancement package versions in your ABAP-based SAP system.
You can have just one enhancement package version in the SAP system. This means, if you have already
updated product instances to a previous EHP you need to apply the current EHP to those components as well.

SAP enhancement packages are cumulative, meaning that each new enhancement package includes new
innovations of its own as well as all innovations delivered with prior packages.

We recommend installing the latest available enhancement package version.
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e |nstall enhancement packages and Support Packages in one single step (this includes the preconditioned
Support Packages).

e SAP enhancement packages have Support Packages of their own that are equivalent to the Support Package
versions of the underlying SAP system.

e SAP enhancement packages have the same maintenance period as the underlying core application.

® The installation of an enhancement package is irreversible.

® Aslong as you do not activate a business function, the installation of an enhancement package has no impact
on existing business processes or user interfaces.
You can only activate business functions in ABAP-based systems, not in Java-based SAP systems.

e The activation of most business functions and extension sets is irreversible. Only a small number of business
functions is reversible.
Test the installation process and activation of new functions in advance on a sandbox system. Ensure that you
evaluate the runtime and the SAP system behavior, its dependencies and impacts. Make sure that your SAP
system is free of errors before going live.
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2 Planning SAP NetWeaver 7.3 incl. EHP 1

The general sequence for the implementation of an SAP NetWeaver system is as follows:

M w oo

You plan the system landscape for the use cases.
You install the components of your SAP NetWeaver system.
You configure your systems.

You plan the implementation (such as scope, hardware and software requirements, release restrictions).

In the following, you find information about the planning of SAP NetWeaver 7.3 including enhancement package 1.

e Major Planning Steps and Related Documentation [page 20]

e Planning the Uses Cases and their System Landscapes [page 21]

2.1

Major Planning Steps and Related Documentation

During an implementation project, you have to take into account many aspects and to take various decisions. The
major planning steps of this process are outlined below.

Table 7:

Step Description

Documentation

Scope and Requirements

You determine the scope of your SAP Net-
Weaver implementation.

For more information, see SAP NetWeaver
Use Cases [page 10].

Installable Software Units

You determine which installable software
unit (that is, systems with product instan-
ces, standalone engines, optional stand-
alone units and clients) are required for the
use cases.

For more information, see the Mapping of
Use Cases to Installable Software Units
[page 13] section.

For details about the software units, see De-
scription of Software Units [page 55].

Landscape Planning

You determine the system landscape and
consider the landscape-relevant aspects
concerning your required use case.

See Planning the Uses Cases and their Sys-
tem Landscapes [page 21].

Hardware & Software Prerequi-

Use the Product Availability Matrix to check

http://support.sap.com/pam

sites which platforms (operating systems, data-
bases, browsers) are supported for your
SAP NetWeaver components.
Check which hardware sizing is required for | http://service.sap.com/sizing#
your SAP NetWeaver release.
SAP NetWeaver Master Guide
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Step Description Documentation
Release Restrictions Check SAP Notes for any release restric- ® Regarding SAP NetWeaver 7.3, see SAP
tions. Note 1407532 ¥

e Regarding SAP enhancement package 1
for SAP NetWeaver 7.3, see SAP Note

1522700 %% .
Solution Manager Prerequisites | We recommend to always use the latest e See SAP Note 631042 for informa-
SAP Solution Manager release. tion about the Release strategy for Im-

plementation Content (ST-ICO).

e See SAP Note 7814484 for informa-
tion about Support Package levels of
Solution Manager installations and up-
grades.

e The Solution Operations Guide for SAP
Solution Manager is available at: http://

Make sure that your SAP Solution Manager
system has the required support package
level and content.

Check if you need to do an update or up-
grade of your SAP Solution Manager appli-
cation or content.

After an upgrade or update to the latest SAP service.sap.com/instguides # |

Solution Manager release, you need to do
. & you Installation & Upgrade Guides > SAP

follow-up actions described in the section

Software Change Management of the Components » SAP Solution Manager

Solution Operations Guide. > <Release> > Operations ]

2.2 Planning the Use Cases and Their System Landscapes

In the following, you get information about the system landscapes for the different SAP NetWeaver uses cases

® Building Composite Applications [page 22]

e Building Integration Scenarios [page 30]

e Data Warehousing [page 36]

e Mobilizing Business Processes [page 38]

® |ntegrating and Self-Servicing Content with SAP NetWeaver Portal [page 40]
e Custom Application Development [page 41]

e SAP Knowledge Warehouse [page 42]

For some uses cases, you get some additional planning information.

= Recommendation

e For more details and aspects regarding the System Landscape Design and Infrastructure, we refer you to
the information about Landscape Design and Infrastructure that you can access from the document
Technical Enablement - Application Lifecycle Management in the Software Community Network (SCN).

Choose http://scn.sap.com/docs/DOC-23404#%|p Landscape Design and Infrastructure 3.
e See also the information about Preparing the System Landscape Directory (SLD) in the SAP NW731 Library,
available at http://help.sap.com/nw731#|» System Administration and Maintenance Information »

Technical Operations for SAP NetWeaver » Section: Administration of SAP NetWeaver systems and
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components » Technical Operations for SAP NetWeaver Development Infrastructure (DI) » Development
Infrastructure (DI) » Configuring the Development Infrastructure  Preparing the System Landscape

Directory (SLD) 3.
e Furthermore, see the information about Managing System Landscape Information in the Help Library for
the Solution Manager.

Choose http://help.sap.com/solutionmanager71#&|p Application Help  SAP Library ¥ SAP Solution
Manager 7.1 SP<version> » SAP Solution Manager Operations » Landscape Management Database

(LMDB): » Managing System Landscape Information 3.

2.3 Building Composite Applications

2.3.1 System Landscape for Building Composite Applications

In order to plan the system landscape for SAP NetWeaver Composition Environment (SAP NetWeaver CE) you
should start by answering the following questions:

e \Which back-end systems are required?

The answer to this question depends on the functions and data you would like to use to build your composite
applications, and whether you want to continue using existing software, such as the software lifecycle
management functions of your back-end system.

e Which central product instances of SAP NetWeaver can be shared when using SAP NetWeaver CE in
combination with SAP NetWeaver Portal or in combination with SAP NetWeaver Process Integration (SAP
NetWeaver PI)?

SAP NetWeaver Master Guide
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The following graphic gives an overview of SAP NetWeaver CE in a system landscape using SAP NetWeaver
Process Integration, SAP NetWeaver Portals, and already existing back-end systems:

SAP NetWeaver 7.3 / 7.31 System Back-End Systems
SAP NetWeaver Systems
SAP NetWeaver Portal
SAP NetWeaver SAP NetWeaver 7.0
EPC — Application Portal /37731
Additional Portal Product Instances
SAP NetWeaver 7.0 SAP NetWeaver 7.0
o
g_ Compeosition Environment Platform
=
a Portal pun SAP ERP
o
g SAP NetWeaver
n;T Additional CE Product Instances
o
Other Systems
ES Repository Thirdparty
Development Non-SAP Back-End
Infrastructure Systems
Additional Pl Product Instances
ES Workspace
SAP NetWeaver Pl (SDN)

Figure 1: SAP NetWeaver CE Combined with Other Use Cases and Back-End Systems

The following sections give recommendations for possible shared usages or installation requirements in your
system landscape, for example, with respect to the following options shown in the graphic above:

e Enterprise Services Repository can both be used for SAP NetWeaver CE and SAP NetWeaver PI. See section
Working with Enterprise Services Repository below for more details.

e The Composition Environment Platform contains the functional unit Portal that offers — apart from minor
exceptions — the same functionality as product instance EP Core — Application Portal for SAP NetWeaver
Portal. See section Working with SAP NetWeaver Portal below for more details.

Connecting to Back-End Systems

You can integrate and use a back-end system in the following scenarios:

® You access data residing on a back-end system.
You can reuse existing data in the composite applications. For example, if you want to use data residing in an
SAP ERP system, you can use the SOA capabilities (in SAP ERP 6.0 systems based on SAP NetWeaver 7.0
Support Package Stack 9 or higher) or you can connect using Remote Function Calls (RFC) to older systems
using the Java Connector (JCo) that is offered as a part of SAP NetWeaver AS Java.

® You use enterprise services on SAP or non-SAP back-end systems.
You can leverage the SOA capabilities of SAP NetWeaver by consuming services provided by an SAP back-
end system such as SAP ERP 6.0 (on SAP NetWeaver 7.0 SPS9 or higher), or the ES Workplace that you can
access using the SAP Community Network (SDN) at http://scn.sap.com/community/soafs. Note that you
can use the ES Workplace in this context only to try some features out, it is not intended for productive use.
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In addition, you can consume services from a third-party back-end system using the standard-based web
service capabilities of the stack. The SAP NetWeaver AS Java installation includes a Services Registry that
enables you to browse the registered service definitions.

Working with Enterprise Services Repository

As a prerequisite for using Enterprise Services Repository (ES Repository), the System Landscape Directory is
needed where products and software components are maintained. You can create your own products and
software component versions in the System Landscape Directory. Before the start of development, you need to
import the required software component versions from the System Landscape Directory into the ES Repository.

1 Note

Note that the following JAVA archives are installed among other software components as part of Enterprise
Services Repository:
® ChartDirector.jar

® jide.jar

We recommend using Enterprise Services Repository on the same AS Java where you use the Services Registry
for building composite applications.

If you use SAP NetWeaver systems for building composite applications and for building integration scenarios
(using SAP NetWeaver PI), we strongly recommend maintaining all your design objects in one ES Repository.

SAP NetWeaver Pl is tightly coupled with ES Repository and requires configuration to connect to a given ES
Repository. By default, Pl connects to the default ESR delivered with SAP NetWeaver PI, while you can use any ES
Repository for building composite applications. We recommend using the latest version of ESR in the landscape.

More information at: http://help.sap.com/nw731#& | Application Help » SAP Library » SAP NetWeaver » SAP
NetWeaver Composition Environment » Administrator's Guide » Configuring Composition Environment »
Configuring Additional Components » Configuring Enterprise Services Repository » Configuring a Central ES
Repository in a CE and Pl Landscape 3.

Working with SAP NetWeaver Portal

Integrating Applications into SAP NetWeaver Portal

Once you create and run your applications on the SAP NetWeaver CE system, you can use standard portal
capabilities for integrating Java applications into iViews.

e For back-end connectivity to SAP transaction and BEx Web iViews, use the portal system landscape overview.

e To enable back-end connectivity for other application types, such as composite views and processes, use
Remote Function Calls (RFCs) and Web services, which are configured in SAP NetWeaver Administrator.

For more information, see http://help.sap.com/nw731#& |+ Application Help » SAP Library » SAP NetWeaver »
SAP NetWeaver Composition Environment » Administrator's Guide » Administering Composition Environment
Additional Administration Tasks » Integrating Content into the SAP NetWeaver Portal CE .

SAP NetWeaver Master Guide
24 PUBLIC Planning SAP NetWeaver 7.3 incl. EHP 1


http://help.sap.com/disclaimer?site=http://help.sap.com/nw731
http://help.sap.com/disclaimer?site=http://help.sap.com/nw731

Running Composite Applications in SAP NetWeaver Portal

Once you have integrated your composite applications into SAP NetWeaver Portal, the following scenarios have to

be distinguished:

® Running composite applications in a portal when developing and testing them in your landscape.

e Allowing business users to access composite applications in a productive environment.

Depending on the scenario, either product instance Composition Environment Platform (CEP) is sufficient or a
local Portal installation (product instances EPC — Applications Portal (EPC) and optionally Enterprise Portal (EP)),
or aremote SAP NetWeaver Portal installation is required. In the following table, the terms local and remote are to
be understood from the viewpoint of an SAP NetWeaver 7.3 including enhancement package 1 installation:

Table 8:

Developing and Testing

Accessing Composite Applications in Productive Environ-

ments

SAP NetWeaver 7.3 including
enhancement package 1

SAP NetWeaver 7.0, SAP Net-
Weaver 7.3, or SAP NetWea-

3rd Party Solution

Product ver 7.31
Required Product Instance CEP* EPC* (EP**) —
Type of Access Local Local (SAP enhancement Remote

package 1 for SAP NetWeaver
7.3) and remote (SAP Net-
Weaver 7.0, SAP NetWeaver
7.3, and NetWeaver 7.31)

Additional Information

Note that the portal installed
with product instance Com-
position Environment Plat-
form can function as a pro-
ducer portal only; consumer
capabilities are therefore not
supported.

You can enable the runtime
access of composite applica-
tions from a remote SAP Net-
Weaver 7.0, SAP NetWeaver
7.3, or SAP NetWeaver 7.31
Portal, either by using the
SAP NetWeaver Portal iView
Wizard, or by setting up a fed-
erated portal network.

* The installation of product instance EPC allows you — in addition to the functions provided by product instance
Composition Environment Platform — to enable the runtime access of composite applications in the portal on the
local system using GPAL and the iView wizards.

** Product instance EP requires product instance EPC and extends the portal to a full Enterprise Portal. For more
information, see section System Landscape Aspects for Integrating and Self-Servicing Content with SAP

NetWeaver Portal [page 40].

For more information about enabling runtime access from a remote SAP NetWeaver 7.0 or SAP NetWeaver 7.3
portal, see http://help.sap.com/nw731#% | Application Help » SAP Library » SAP NetWeaver » SAP NetWeaver
Composition Environment » Administrator's Guide » Administering Composition Environment » Additional

Administration Tasks » Running CE Applications in Remote Portals (Optional) 3.
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2.3.2 Further Aspects for Your Installation Planning
Overview

The following graphic shows the software units that are used for Building Composite Applications:

Clients

) Adobe .
Develo_per De\.nieloper Web Browser LinsErel Visual :
Studio Workplace Desi i Composer

esigner
|

I I

Systems with Product Instances Standalone
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DI (optional) ADS (optional) Dispatcher

NW Product Description

Figure 2: Software Units for Building Composite Applications
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When setting up the system landscape, you need to consider the development environment for each developer
and the overall system landscape for developing, testing, and running composite applications:

e Developer Workplace
The Developer Workplace consists of an installation of an AS Java including additional product instances for
the development of composite applications, and SAP NetWeaver Developer Studio on the developer's PC for
development that involves local testing before changes are published to a central AS Java. This is also the
preferred option for developing composite applications that are not intended to be used productively — for
example if you would simply like to learn more about the technologies of SAP NetWeaver for composite
applications.

e Composite Application Development, Test, and Production Systems
We recommend using a combination of development system, test system, and production system with a
central AS Java to develop, consolidate, test, and run your application productively. This is also the preferred
option for developing a composite application in a team of developers.

In order to describe these two scenarios, the following sections focus on the AS Java, the Developer Studio, and
the Developer Workplace, because the installation is tailored to these main software units. Of course, additional
product instances or clients need to be installed in addition depending on your scenario.

For information about supported operating systems and data bases, see the Product Availability Matrix for SAP
NetWeaver 7.3 or SAP enhancement package 1 for SAP NetWeaver 7.3 available at http://support.sap.com/pam
i
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Planning Your Developer Workplace Installation

The following graphic shows the installation options for individual developments in non-productive development
projects:

Developer Workplace

Developer Studio

Additional Product Instances

Figure 3: Developer Workplace Components

To implement a complete development environment on a single developer PC, set up a developer workplace.

e You can install the Application Server Java (AS Java) in development mode together with SAP NetWeaver
Developer Studio on a single host. Setting up the AS Java in development mode does not require specific
infrastructure settings (such as setting up special users or shares) and saves hardware resources. It includes
the installation of a single server instance ( multiple server nodes are possible). You can install additional
software units, see Mapping of Use Cases to Installable Software Units [page 13].

e Optionally, the SAP NetWeaver Developer Studio can be installed on additional developer PCs based on a
central AS Java. However, if you intend to carry out team development projects for productive purposes, we
strongly recommend installing a central AS Java in productive mode as described in the next chapter.

= Recommendation

Use the update site mirror to keep features of the Developer Studios up-to-date. With the Update Site Mirroring
wizard included in the Developer Studio, you can create a mirror of an update site on a local machine. You can
grant access to the mirror for users who need these updates but do not have access to SAP Service
Marketplace. You can use any HTTP server and even a file share as the local update server. For more
information, see http://help.sap.com/nw731#|» Application Help » SAP Library » SAP NetWeaver
Composition Environment » Developing Composite Applications » SAP NetWeaver Developer Studio Basics ¥
Creating and Maintaining Update Site Mirrors 3
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Planning Your Installation of SAP NetWeaver Development, Test, and
Production Systems for Composite Applications

When using SAP NetWeaver for development of composite applications aimed for productive use, we strongly
recommend setting up a system landscape consisting of the following systems:

e Development System and Test System
Use these systems for development and quality assurance.

® Production System
Use this system to run your applications separately from your development and test landscape.

The system landscape supports consolidating and testing individual development and, as a consequence, is
strongly recommended for team development projects.

The following graphic provides an overview of the recommended system landscape:
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With respect to the installation of the development environment, you have the following options:

e Youinstall an AS Java centrally and the developer workplace on each developer host.

This option is recommended for large development projects with a need for local and central testing.
Developers can test their developments locally using the developer workplace. For integration tests, they

deploy their changes on the central AS Java.

e Youinstall an AS Java centrally and Developer Studio instances on each developer host.
This option requires fewer hardware resources per developer host. In this landscape scenario you can set up
an AS Java in development mode centrally and connect to it from the other hosts in the landscape using the

Developer Studio.
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In a production system landscape, you have to install a central 64-bit SAP NetWeaver Application Server Java in
productive mode for running composite applications to address additional runtime requirements such as
clustering and higher default memory settings. We strongly recommend installing a central 64-bit server in
productive mode for both the test system landscape and the development system landscape as well. We do not
recommend using the AS Java of the Developer Workplace in productive mode.

2.4 Building Integration Scenarios

You can either install SAP NetWeaver Process Integration as a standard installation (dual-stack system) or the
Advanced Adapter Engine Extended (AEX), which is based on AS Java only. Both options are described in System
Landscape for Building Integration Scenarios [page 30].

Furthermore, you have the possibility to install the Process |Orchestration [page 34].

2.4.1 System Landscape for Building Integration Scenarios

The standard installation (dual-stack) offers the complete functional range, whereas the functional range of AEX
is restricted, but has the advantage of a lower TCO.
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The following figures depict both options:
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Figure 4: System Landscape for Building Integration Scenarios with Pl Standard Installation
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When you choose the Process Integration installation option in the installation tool, all dependent product

instances are selected and installed automatically.
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Figure 5: System Landscape for Building Integration Scenarios with Advanced Adapter Engine Extended

When you plan your system landscape for building integration scenarios, consider the following aspects:

32

It is mandatory to have a dedicated Pl system. This applies to development, quality, and production
landscapes.

For Pl, it is a prerequisite that no other system in your system landscape has a higher release than the Pl
system. For exceptions to this rule, see SAP Note 104304 7#% . For example, SAP XI 3.0 is compatible with
SAP NetWeaver 6.40 and 7.0 application systems since the same Xl protocol is used. Apart from these
exceptions, if you want to upgrade or install an application in your system landscape, you first have to make
sure that the Pl system is on the same release level. If required, you have to upgrade the Pl system first to the
new or a higher release.

Caution

Although it should be technically possible to run an application system with a higher release than your PI
system in your system landscape, this is not supported by SAP (apart from the exceptions listed in SAP
Note 104304 7#% ). Therefore, you run such a landscape at your own risk.

You can use the Advanced Adapter Engine that is part of your Pl system as a central Advanced Adapter
Engine. You can optionally deploy additional non-central Advanced Adapter Engines.
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Adapter Engine (Java SE) can be installed in a non-SAP Java environment. However, it only hosts a subset of
the adapter functionality, is only supported for compatibility reasons, and should be used only if this is a
precondition in your environment. The following table shows the characteristics of the central Advanced
Adapter Engine, the non-central Advanced Adapter Engine, and the Adapter Engine (Java SE) as an overview:

Table 9:

Installation Option

Central Advanced Adapter Engine on the Pl host

o

o

o

’ Characteristics

No additional installation procedure required

Suitable for development or test scenarios

Data source (file, database, JMS provider) must be ac-
cessible using NFS, tcp-ports, and so on (may only be
available in homogeneous LAN environments).
Possible performance bottleneck due to high RAM
needs. The system needs three times the amount of
the maximum message size as RAM, for example.

Non-central Advanced Adapter Engine

Provides complete integration into the Pl environment:
o Central Monitoring available
o Central Configuration available

More resources needed for installing the SAP NetWea-
ver Java system

Adapter Engine (Java SE)

Installation possible on non-released SAP NetWeaver
platforms

Only HTTP connection required between adapter en-
gine and Integration Server. Suitable for a more hetero-
geneous system landscape with mixed operating sys-
tems and authorization concepts, or for distributed
WAN environments with firewalls, and so on.

Fewer resources needed when running in a Java envi-
ronment only

Additional installation procedure required for JDK and
the adapter itself

Poorer integration with the SAP NetWeaver Process In-
tegration environment due to lack of central configura-
tion and monitoring services

® You can install an Advanced Adapter Engine Extended (AEX). This provides tools for designing and
configuring integration content (Enterprise Services Repository, Integration Directory and System Landscape
Directory), as well as the Advanced Adapter Engine as a runtime engine. This installation option is based on
AS Java only and you can use it without a standard Process Integration system. You can optionally deploy

additional non-central Advanced Adapter Engines.

1 Note

Regarding the deployment of any other product instance besides Business Process Management (BPM) on
an existing Advanced Adapter Engine Extended (AEX), see SAP Note 1868764 .
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The following table compares the Advanced Adapter Engine Extended to an SAP NetWeaver Process
Integration standard installation:

Table 10:
Installation Option Advantage Disadvantage
Advanced Adapter Engine Extended o Easy toinstall and to maintain o Connectivity options restricted to
(Java only) adapters of AAE
o Fewer resources needed o Integration processes not availa-
ble

o Only process integration scenar-
jos available as ESR modeling op-
tion

SAP NetWeaver Process Integration o Complete functional range of SAP | © More memory and data storage

NetWeaver Process Integration required

o More cost-intensive

1 Note
User Management

o If you deploy non-central Advanced Adapter Engines with Advanced Adapter Engine Extended (AEX),
use the Local User Management (UME Configuration "Java Database") on the non-central Advanced
Adapter Engines. At runtime the non-central Advanced Adapter Engines work independently of the
AEX.

o If you deploy non-central Advanced Adapter Engines with PI, use the ABAP User Management on the
Pl system.

e The AS ABAP system acts as an application and service provider. For Java Web Services, you also require AS
Java. In addition, you require SAP NetWeaver Developer Studio on the client side as a development
environment.

The Web service client can be either an SAP or a non-SAP application. For example, an AS ABAP system or a
Web browser could act as an application or service consumer.

2.4.2 Process Orchestration

Use

Process Orchestration provides a tool infrastructure to model and design business processes — from the overall
process flow and the sequence of activities up to the interfaces and data types that are needed to integrate SAP
systems and external systems. It combines the integration capabilities of SAP NetWeaver Process Integration
(Advanced Adapter Engine Extended (AEX) installation option) with the process modeling, operation, and
monitoring capabilities of SAP NetWeaver Business Process Management (BPM). Like AEX, Process
Orchestration is based on AS Java only.
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Integration

The package is based on the following components:

e Components of the Advanced Adapter Engine Extended (AEX), in particular:

o Enterprise Services Repository

Enables you to design integration content like service interfaces and mappings, for example.

o Integration Directory

Configuration tool that allows an integration expert to configure integration content, in particular: One the
one hand, to specify the business communication between business systems and Process Orchestration
and, on the other hand, to specify the connectivity between the BPM process and the Process Integration

runtime.
o Advanced Adapter Engine

Process Integration runtime component that allows you to process XML messages.

® Business Process Management and Business Rules Management engines
Allows an integration expert to model business processes and to execute and monitor the business processes

(BPM-based applications) at runtime.

The involved components are illustrated in the figure below.
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Figure 6: Components of Process Orchestration
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1 Note

You can obtain Process Orchestration by installation or by adding the corresponding product instances to an
existing SAP NetWeaver system. For latter, both are supported, deployment of BPM on an existing AEX system
and deployment of an AEX on an existing BPM system.

Regarding the deployment of additional product instances besides BPM and AEX, see SAP Note 1868764 #r .
You can deploy non-central Advanced Adapter Engines with Process Orchestration.

Constraints

® Process Orchestration runs on one system. The deployment on more than one system is not supported.

® Process Orchestration can be installed in a cluster. Every node would have an AEX and a BPM instance
running

More Information

See the Help Portal at:

e http://help.sap.com/nw731#&| Application Help  Function-Oriented View » Process Integration J

2.5 System Landscape for Data Warehousing

The following figure shows the software units that are used for data warehousing.
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Figure 7: Data Warehousing

1 Note

The SAP BusinessObjects products Web Intelligence, Analysis, Crystal Reports and Xcelsius require seperate
licenses.

® You need Bl Java and the Java-based product instances for specific capabilities only, which are the following:

o SAP Business Explorer
You need Bl Java, EP Core — Application Portal, and Enterprise Portal for SAP Business Explorer (BEx)
tools and runtime, for example, BEx Web, Information Broadcasting, and Portal Integration.

o BW Administration Cockpit
You need Bl Java, EP Core — Application Portal, and Enterprise Portal if you want to use the BW
Administration Cockpit. The BW Administration Cockpit is part of a business package that is installed in
the SAP NetWeaver Portal.

o Wizard-based Configuration of SAP NetWeaver BW (ABAP)
You need AS Java if you want to use the wizard-based configuration for basic configuration settings for
SAP NetWeaver BW (ABAP).

o UD Connect
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You need AS Java if you want to use UD Connect.

o With SAP NetWeaver BW, powered by SAP HANA database, SAP offers the SAP HANA database being
the in-memory deployment option for the Data Warehousing use case: SAP HANA SPS 04 can be used as
database platform for BW ABAP in SAP Enhancement Package 1 for SAP NetWeaver 7.3, SPS 04 and
higher. For information on implementation considerations and implementation sequence, see End-to-End
Implementation Roadmap for SAP NetWeaver BW, powered by SAP HANA at http://service.sap.com/
instguidesnw73r, and SAP Note 16009297 as well.

e For more information, see

o SAP Community Network: http://scn.sap.com/community/data-warehousing

o Help Portal: http://help.sap.com/nw73bwhanaf
Help Portal: http://help.sap.com/nw731#% | Application Help » SAP Library » SAP NetWeaver Business
Warehouse 3

o

[¢]

Help Portal: http://help.sap.com/nw731# | Application Help » Function-Oriented View » Business
Warehouse J

1 Note
SAP Strategic Enterprise Management

If you have the SEM-BW add-on installed in your source release, read the following information in the SAP
Community Network: http://scn.sap.com/docs/DOC-12042 #r .

2.6 System Landscape for Mobilizing Business Processes

Use

1 Note

SAP NetWeaver Mobile is only available as add-on to SAP enhancement package 1 for SAP NetWeaver 7.3. For
more information, see SAP Note 1645275 .

The following figure shows the system landscape for Mobilizing Business Processes.
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Figure 8: Enabling Mobile Applications for Occasional Connectivity/Developing Mobile Applications for Occasional Connectivity

The SAP NetWeaver Developer Studio and an SAP NetWeaver system with product instance DI are only
required for developing mobile applications.

Product instance Dl is required if multiple developers work with Mobile Web Dynpro Offline. Instead of using
SAP NetWeaver Development Infrastructure, you can also use a non-SAP development infrastructure. For
more information, see the SAP Library at http://help.sap.com/nw731#% |+ Application Help » Function-
Oriented View ¥ Solution Life Cycle Management ¥ Using the Development and Production Infrastructure »
Development Infrastructure » Concepts » Development Using Optional Development Infrastructure 3
Optionally you can use SAP NetWeaver Portal for accessing the Mobile functions.

If you have installed SAP NetWeaver Portal (system with product instance EPC ) in your landscape, you can
use it for managing your SAP NetWeaver Mobile landscape, for example for the administration of clients and
back-end systems and for synchronization. Alternatively, you can use the Data Orchestration Engine
administrator only, which is part of product instance Mobile.

You can integrate any SAP or non-SAP system as a back-end system.

More Information

For more information, see the Help Portal at

http://help.sap.com/nw731#& | Application Help » SAP Library » SAP NetWeaver Mobile 3
http://help.sap.com/nw731#& | Application Help » Function-Oriented View » Mobile J
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2.7 System Landscape Aspects for Integrating and Self-
Servicing Content with SAP NetWeaver Portal

Use

SAP NetWeaver Portal (product instances EPC and EP) provides the core portal capabilities required to bring SAP
NetWeaver to (internal and external) users in a uniformed and consistent manner. It offers a single point of access
through a Web front end to SAP and non-SAP information sources, enterprise applications, information
repositories, databases and services across organizational and technical boundaries - all integrated into a single
user experience. Product instance EPC is a prerequisite for using the portal add-on capabilities provided by
product instance EP. EPC alone provides a leaner portal installation and implementation where full enterprise
portal capabilities are not required.

The following figure shows the software units that are used for Integrating and Self-Servicing Content with SAP
NetWeaver Portal.

Clients

Web Browser

Systems with Product Instances Standalone Engines

EPC — Application Portal Web Dispatcher

AS Java Extensions

NW Product Description Search and Classification (TREX)

AS Java

Figure 9: Integrating and Self-Servicing Content with SAP NetWeaver Portal
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More Information

For more information, see the Help Portal at

e http://help.sap.com/nw731¢|» Application Help » SAP Library » SAP NetWeaver Portal 3
e http://help.sap.com/nw731# | Application Help » Function-Oriented View @ Enterprise Portal 3

2.8 System Landscape for Custom Application Development

Use

The Application Server ABAP provides the ABAP foundation of SAP NetWeaver. AS ABAP provides a complete
development and runtime environment for ABAP-based applications. It is optimized for the development of highly
scalable business applications. The ABAP development and runtime environment makes it possible to develop
complex business applications without having to worry explicitly about technical details such as process or
memory administration, multi-user capability, database connections, or similar issues. These are provided in the
basic services of the Application Server ABAP or are integrated directly in the ABAP runtime. The application
development is similarly independent of the underlying platform. The application server decouples the application
coding completely from the operating system and database that are used. Using ABAP, you can run custom
development projects to create and enhance business functions in the backend, and you can develop Web Dynpro
ABAP applications in different scenarios.

The preferred SAP NetWeaver version for custom application development in ABAP is SAP NetWeaver 7.0 as part
of the SAP Business Suite. SAP Business Suite is based on SAP NetWeaver 7.0 and the features of AS ABAP
included in SAP Business Suite 7i2010 and SAP NetWeaver 7.3 have been aligned to a great extent.

With SAP enhancement package 1 for SAP NetWeaver 7.3, the stack consolidation brings the advantage that the
features with regard to AS ABAP included in the SAP Business Suite 7i2011 and SAP enhancement package 1 for
SAP NetWeaver 7.3 are the same because both are build on AS ABAP 7.31. Although we still recommend to use
the SAP NetWeaver 7.0 for custom application development, SAP enhancement package 1 for SAP NetWeaver 7.3
can also be used instead.

The following figure shows the software units that are used for Custom Application Development.
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More Information

For more information, see the Help Portal at http://help.sap.com/nw731# |k Application Help » Function-
Oriented View » Application Server ¥ Application Server ABAP ¥ Application Development on AS ABAP 4.

2.9 System Landscape for SAP Knowledge Warehouse

SAP Knowledge Warehouse (SAP KW) is a solution within SAP NetWeaver that delivers the infrastructure you
need to set up and manage your own enterprise-specific knowledge base in the areas of documentation, training,
and manuals. For project teams and end users, SAP Knowledge Warehouse streamlines training and business
processes, helping to reduce costs. In addition, the ability to reuse, supplement, and continually update SAP
content offers a great savings potential.

SAP KW provides an information repository for companies of all sizes - including global multilingual companies -
with facilities to model structures according to their corporate and market structure.

The following figure shows the software units that are used for SAP Knowledge Warehouse.
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3 Implementing SAP NetWeaver 7.3 incl.
EHP1

The general sequence for the implementation of an SAP NetWeaver system is as follows:

You plan the implementation (such as scope, hardware and software requirements, release restrictions).
You plan the system landscape for the use cases.
You install the components of your SAP NetWeaver system.

AW

You configure your systems.

In the following, you find information about the installation and configuration steps for SAP NetWeaver 7.3
including enhancement package 1.

e |[nstallation Procedure [page 44]

e |[nstallation Tool [page 51]

e Configuration of Systems and Follow-Up Activities [page 51]

e System Copy and Migration [page 53]

3.1 Installation Procedure

Use

The installation procedure is divided into the following sections:

Preparation

Installation of required SAP NetWeaver systems
Installation of optional standalone units
Installation of standalone engines

os W

Installation of clients

Procedure

1 Note
Documentation:

Unless stated otherwise, the documentation is available at http://service.sap.com/installnw73#r .

1. You prepare the installation procedure.
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Table 11:

Tasks

You identify the DVDs and archives required for the installa-
tion of the required software units.

Documentation

You normally obtain the installation media as part of the in-
stallation package from SAP. However, you can also download
installation media from the SAP Software Distribution Center
at https://support.sap.com/swdc P

1 Note

Since the material numbers of the corresponding DVDs,
CDs, and archives may change when new updates become
necessary, we recommend that you visit the SAP Software
Distribution Center to make sure that you always use the
most recent version of the indicated data carriers.

For more information, see the section Preparing the Instal-
lation Media in the Installation guide Installing SAP Systems
Based on SAP NetWeaver 7.1 and Higher - Using Software
Provisioning Manager 1.0.

There are specific installation guides for all supported
combinations of technologies (ABAP, Java, or ABAP and
Java), databases, and operating systems.
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Tasks

1

Data Warehousing only:

Optional: You prepare an SAP system as a data source:

The SAP system can be either an OLTP - SAP R/3 sys-
tem (3.1l - 4.6C) or SAP R/3 Enterprise system (Exten-
sion Set 1.10 or higher) or any other SAP system with
PI_BASIS Plug-In.

If you want to use SAP R/3 or SAP R/3 Enterprise as a
data source, make sure that SAP R/3 Plug-In 2004.1 is in-
stalled on the OLTP system: See SAP Note 704564 #%
(R/3 plug-in:P1 2004.1 installation/delta upgrade) and
SAP Service Marketplace at http://service.sap.com/r3-
plug-infe

1 Note

New and extended interfaces for integrating SAP R/3,
SAP R/3 Enterprise, and SAP ERP Central Component
(SAP ECC) are no longer delivered with their own add-
on (SAP R/3 Plug-In). As of SAP ECC 6.0, they are di-
rectly included in SAP ECC. Therefore, this step is not
required for SAP ECC 6.0 or higher.

If you want to install SAP NetWeaver BW on the SAP
HANA database, ensure that your certified hardware
partner has pre-installed the SAP HANA SP04 software
on a separate server than the BW system. For more infor-

mation, see http://help.sap.com//hana_platform#.

Documentation

2. You install the required SAP NetWeaver systems.
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Table 12:

Tasks

You install SAP NetWeaver systems with the required product
instances.

1 Note

There is no installation option for product instance BW
ABAP, Mobile and PDF Export in the installation tool

software provisioning manager 1.0.

® TosetupaBW system, install a system with product in-
stance AS ABAP and afterwards install SAP NetWeaver
7.03/7.31 Bl Content Add-On 7.46 or SAP NetWeaver
7.03/7.31 Bl Content Extensions Add-On 7.46 on top of
this system.

e Note for SAP NetWeaver BW on SAP HANA database:
The SAP HANA database SP4 has to be pre-installed by
certified hardware partners before the installation of SAP
NetWeaver. The installation accesses the SAP HANA da-
tabase remotely to perform the necessary database-spe-
cific installation steps. The installation includes Enhance-
ment Package 1 for SAP NetWeaver BW 7.3 SPS3.

stallation with a separate database server is supported.
Other applications must not be installed on the database
server apart from the pre-installed SAP HANA database
and additional applications that it requires. This is be-
cause other applications may have a negative affect on
performance. This also includes parts of the distributed
central instance (for example, an application server must
not be installed on the DB server).
For more information, see SAP Note 1600929 #r

e TosetupaMobile system, install a system with product
instance AS ABAP and configure it for Mobile.

Note that only a standard installation and a distributed in-

Documentation

e |nstallation Guide Installing SAP Systems Based on SAP
NetWeaver 7.1 and Higher - Using Software Provisioning
Manager 1.0
There are specific installation guides for all supported
combinations of technologies (ABAP, Java, or ABAP and
Java), databases, and operating systems.

See the following notes in addition:
SAP NetWeaver BW:

e SAP Note 1678780#% : (Installation or upgrade
BI_CONT/BI_CONT_XT 707/737/747), and the following
overview notes:

o SAP Note 153967 : (Bl Content Release Strategy)
o SAP Note 1000822 % : (Overview: SAP Notes for the
add-ons BI_CONT and BI_CONT_XT)
SAP NetWeaver Mobile:

e SAP Note 1645275/ (Installation of SAP EHP1 for SAP
NetWeaver Mobile)

SAP Kernel Update

Make sure that you apply the latest kernel as described in the
Support Package Stack Guide.

Installation Guide Installing SAP Systems Based on SAP Net-
Weaver 7.1 and Higher - Using Software Provisioning Manager
10

There are specific installation guides for all supported combi-
nations of technologies (ABAP, Java, or ABAP and Java), da-
tabases, and operating systems.
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Tasks

Support Package Stack Update

We recommend that you always apply the latest Support
Package Stack.

As SAP Enhancement Package 1 for SAP NetWeaver 7.3 is
only supported with Support Package 1, you update your SAP
NetWeaver systems to at least Support Package stack O1.

Note that for SAP NetWeaver BW on SAP HANA database,
SAP NetWeaver Support Package Stack 04 or higher is re-
quired.

Caution

Since the initial delivery of the ABAP software stack is
based on Support Package O, you explicitly need to deploy
at least Support Package 1 after your installation, or bind at
least Support Package 1 into the upgrade procedure.

Documentation

You can apply Support Package Stacks on top of SAP Net-
Weaver 7.3 and higher by using the Software Update Manager
tool. See the Update Guide — Update of SAP Systems Using
Software Update Manager 1.0 <SPxx>.

The guide and more information are available at http://serv-

ice.sap.com//maintenancenw?73 .

Process Integration:

After an installation of SAP NetWeaver Process Integration,
you carry out the configuration wizard-assisted basic
configuration in order to configure at least the connection to
the System Landscape Directory (SLD) before you perform
the support package installation step.

Further CTC Wizard-assisted basic configuration steps can be
performed after the Solution Manager Configuration and the
Support Package Installation.

Configuration documentation on SAP Help Portal at: http://
help.sap.com/nw73lfbl} Application Help > Function-
Oriented View > Process Integration > Configuring Process

Integration After Installation |

You install the SAP Library in your system.

Installation Guide Installing SAP Library for SAP NetWeaver
Based Systems - Using Software Provisioning Manager 1.0

3. You install optional standalone units.
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Table 13:

Tasks

You can find the following software units in the installation tool
software provisioning manager 1.0 under Optional

Standalone Units:

e Advanced Adapter Engine (PI-AF)
e Advanced Adapter Engine Extended (PI-AEX)

® Process Integration and Orchestration Package (PI-CP)

Documentation

Installation Guide Installing SAP Systems Based on SAP Net-
Weaver 7.1 and Higher - Using Software Provisioning Manager
10

There are specific installation guides for all supported combi-
nations of technologies (ABAP, Java, or ABAP and Java), da-
tabases, and operating systems.

You can find additional configuration information on SAP Help
Portal at: http://help.sap.com/nw731$|} Application Help
> Function-Oriented View > SAP NetWeaver Library:
Function-Oriented View > Process Integration > Configuring

Process Integration After Installation }

Choose:

e Configuring Process Integration (Pl) Dual-Stack

e Configuring Advanced Adapter Engine Extended (PI-AEX)

e Configuring Process Orchestration (PI-CP)

e Configuring the Non-Central Advanced Adapter Engine

e Configuring the Non-Central Advanced Adapter Engine for
AEX

RTC Application Sharing Server:

If you plan to install product instance EP for real-time collabo-
ration capabilities (instant messaging and application shar-
ing), refer to SAP Note 1038125#% . For production use of RTC
application sharing, we recommend installing an additional
product instance EP on a dedicated server as a standalone
unit.

4. You install the standalone engines.

Table 14:

Tasks

Web Dispatcher

Documentation

Installing Web Dispatcher for SAP Systems Based on SAP Net-
Weaver 7.1 and higher using Software Provisioning Manager
10

Standalone Gateway

Installing Gateway for SAP Systems Based on SAP NetWeaver
7.1and higher using Software Provisioning Manager 1.0

liveCache

Installing SAP liveCache Using Software Provisioning Manager
1.0: <Operating System>
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Tasks

Search and Classification (TREX)

Documentation

SAP NetWeaver Search and Classification (TREX):
e [nstallation Guide — SAP NetWeaver Standalone Engine
Search and Classification (TREX) 7.1 Single Host

e |nstallation Guide — SAP NetWeaver Standalone Engine
Search and Classification (TREX) 7.1 Multiple Hosts

Content Server

Installation Guide — SAP Content Server 6.40, available at:
http://service.sap.com/installnw70"hr|} Installation >
Standalone Engines }

Adapter Engine Java SE

SAP Help Portal at: http://help.sap.com/nw731#
|+ Application Help ¥ Function-Oriented View # SAP
NetWeaver Library: Function-Oriented View  Process

Integration > Adapter-Engine (Java SE) > Installation }

5. You install the clients.
Table 15:

Tasks

SAP GUI for Windows

Business Explorer

During the installation of SAP GUI, you can choose to install

the BW Add-On and BI Add-On for the SAP Business Explorer.

Note that SAP GUI for HTML and SAP GUI for Java do not
have all the capabilities of SAP GUI for Windows. BEx Query
Designer, BEx Analyzer and Uls with network controls are not
supported with SAP GUI for HTML and SAP GUI for Java.

Adobe LiveCycle Designer

Documentation

SAP Front End Installation Guide

SAP NetWeaver Business Client

SAP Help Portal at http://help.sap.com/nw73
|} Application Help > SAP Library > Administration
Information > Technical Operations for SAP NetWeaver >

Technical Operations for SAP NetWeaver Business Client ]

Mobile Client

SAP Help Portal at http://help.sap.com/nw731#

|} Application Help > Function-Oriented View > SAP
NetWeaver: Function-Oriented View ¥ Mobile * Configuring
SAP NetWeaver Mobile > Installing Mobile-Specific Software
Units 4
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Tasks Documentation

SAP NetWeaver Developer Studio Installation and Update Guide — SAP NetWeaver Developer
Studio 7.3 including Enhancement Package 1

SAP Enterprise Services Explorer Tool for Microsoft .NET Installation and Configuration - SAP ES Explorer for MS .NET

SAP BusinessObjects clients (Crystal Reports, Xcelsius, Ad- | See the installation guides at: http://help.sap.com/bobifr
vanced Analysis, Web Intelligence)

3.2 Installation Tool

For the new installation of an SAP system including an enhancement package you use the standard installation
tool software provisioning manager 1.0.The software provisioning manager performs software
provisioning processes such as installation, uninstallation, system copy, or system transformation.

Software provisioning manager is the successor of the product- and release-specific delivery of provisioning tools,
such as sapinst. Before you perform an installation or system copy, we recommend that you always download
the latest version of the software provisioning manager, which is part of the Software Logistics Toolset (SL
Toolset for short). This way, you automatically get the latest sSAPinst version including latest fixes in the tool and
supported processes.

For more information about software provisioning manager as well as products and releases supported by it, see
SAP Note 1680045 .

See also the information in the SAP Community Network at http://scn.sap.com/docs/DOC-30430#% and at
https://support.sap.com/sltoolset® | System Provisioning 3.

3.3 Configuration of Systems and Follow-Up Activities

Before you can start working with your SAP NetWeaver installation, you have to adapt it to your needs.

Configuration

The SAP Solution Manager contains descriptions of all configuration tasks, and leads you to automated
configuration procedures, where available.

1. Tobe able to use SAP Solution Manager for configuring your systems, you have to import the latest available
Support Package for the SAP Solution Manager Implementation Content (Add-On ST-ICO). For more
information, see SAP Note 631042% (Release strategy for Implementation Content (ST-ICO)).

SAP Solution Manager Implementation Content is available at https://support.sap.com/swdc#e.
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2.

1

To access the configuration tasks, you create a project and a project structure in SAP Solution Manager. In
the configuration phase, you select configuration structures with pre-delivered SAP content for your project.
You can either access the configuration task in the configuration structure or create a printable configuration
guide.

For more information, see:

o SAP Library at http://help.sap.com#|» Application Lifecycle Management » SAP Solution Manager »
<release>  Application Help ¥ Solutions Implementation  Implementation/Upgrade Work Center
Configuration 3

o http://support.sap.com# | Support Programs & Services » SAP Solution Manager 3 or http://
support.sap.com/solutionmanager .

o http://support.sap.com/solutionmanager# | Knowledge Transfer » How-To Documents » How to

Create a Configuration Guide using SAP Solution Manager 3
Some configuration activities are automated, that is they are performed using automation tools such as the
configuration wizard. The automation tools support you in performing technical configuration tasks in an
automated way and thus accelerate and simplify the setup of your systems after installing. For more
information, see the Automation Tools node in the configuration structure. In case of ABAP systems, you can
use executable configuration files (IMG activities).

Note

Accessing Use Case information in SAP Solution Manager

You can use the business process repository browser (BPR browser) in SAP Solution Manager at http://
implementationcontent.sap.com/bpr# to access instantly information about the SAP NetWeaver 7.31 use
cases you want to implement::

Choose |» Business Process Repository » Solutions/Applications » SAP NetWeaver 3 to access centrally
all SAP NetWeaver 7.31 use cases.

Choose |F Business Process Repository # Solutions/Applications % SAP Technology @ End-To-End Use

Cases Jto access end-to-end implementation information about Application Life-Cycle Management and
Enterprise Data Warehousing.

Process Integration

Instead of creating your configuration guides with the SAP Solution Manager, you can also find the
configuration information in the SAP Help Portal. Access the SAP NetWeaver 731 Library at: http://

help.sap.com/nw731#| Application Help » Function-Oriented View » Process Integration » Configuring

Process Integration After Installation 3.

1.

52

For configuring the Process Integration (PI) Dual Stack, choose | Configuring Process Integration (Pl) Dual
Stack » Basic Configuration for SAP NetWeaver Process Integration (Pl) 3.
o For configuring the Non-Central Advanced Adapter Engine (PI-AF) for Pl Dual-Stack, choose
|+ Configuring the Non-Central Advanced Adapter Engine (PI-AF) 3.
For configuring the Advanced Adapter Engine Extended (PI-AEX), choose | Configuring Advanced Adapter
Engine Extended (PI-AEX) » Basic Configuration for SAP NetWeaver Pl Advanced Adapter Engine
Extended 3.
o For configuring the Advanced Adapter Engine Extended (PI-AF) for AEX, choose | Configuring the
Non-Central Advanced Adapter Engine (PI-AF) for AEX 3.
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3. For configuring the Process Orchestration (PI-CP), choose | Configuring Process Orchestration (PI-CP) 3.

3.4 System Copy and Migration

Use

At several stages in the lifecycle of your SAP solution, you will face the requirement to perform a system copy or a
migration. For example, SAP recommends that you perform a system copy to create test, demo and training
systems. Also, if you need to change your operating system and/or database, you have to perform a migration of
your SAP system.

For this, SAP is offering system copy and migration services that enable you to create consistent copies of your
SAP systems, flexibly adapted to your needs - be it an SAP system distributed to several hosts, a high-availability
system or a system on a rather exotic operating system/database combination.

More Information

e For anintroduction into system copy and migration, see http://scn.sap.com/docs/DOC-8324#% in the SAP
Community Network.

e System copy guides Copying SAP Systems Based on SAP NetWeaver 7.1 and Higher - Using Software
Provisioning Manager 1.0 are available on SAP Service Marketplace at http://service.sap.com/installnw7 3.

e Alternatively, you can copy your system with a completely automated end-to-end framework available with
the SAP NetWeaver Landscape Virtualization Management <Release>, Enterprise Edition. For more
information, see the SAP Help Portal at http://help.sap.com/nwivm# .
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A Appendix

A.l1 Additional Information for Implementing SAP NetWeaver

The following table contains links to information available on SAP Service Marketplace or in the SAP Library which
is relevant for implementing SAP NetWeaver:

Table 16:

Content Location on SAP Service Marketplace or in SAP Library

Installation and Upgrade Guides for SAP for NetWeaver 7.3 in- | http://service.sap.com/instguidesnw73#r
cluding enhancement package 1

Information about security SAP Security Guide: See the SAP Library at http://
help.sap.com/nw73% |k Security Information » Security
Guide 3.

Information about the technical operation of SAP NetWeaver | Technical Operations Manual: See the SAP Library at http://
help.sap.com/nw73F |k System Administration and
Maintenance Information > Technical Operations for SAP

NetWeaver 1

Information about SAP NetWeaver Support Package Stacks https://support.sap.com/sp-stacks | SP Stack

Information }

Information about installing SAP NetWeaver Support Package http://service.sap.com/maintenancenw73fhr|} Support

Stacks )
Package Stack Guide 4
Information about SAP NetWeaver Capabilities e http://scn.sap.com/community/netweaver#r
® http://scn.sap.com/docs/DOC-8287
SAP Solution Manager Guides All SAP Solution Manager related guides, such as

e Master Guide

e Configuration Guide

e Security Guide Master Guide
e Upgrade Guide

® Solutions Operations Guide

are available at:http://service.sap.com/instguidesﬁrw
Installation & Upgrade Guides > SAP Components > SAP

Solution Manager # <Release> 4

SAP NetWeaver Master Guide
54 PUBLIC Appendix


http://help.sap.com/disclaimer?site=http://service.sap.com/instguidesnw73
http://help.sap.com/disclaimer?site=http://help.sap.com/nw73
http://help.sap.com/disclaimer?site=http://help.sap.com/nw73
http://help.sap.com/disclaimer?site=http://help.sap.com/nw73
http://help.sap.com/disclaimer?site=http://help.sap.com/nw73
http://help.sap.com/disclaimer?site=https://support.sap.com/sp-stacks
http://help.sap.com/disclaimer?site=http://service.sap.com/maintenancenw73
http://help.sap.com/disclaimer?site=http://scn.sap.com/community/netweaver
http://help.sap.com/disclaimer?site=http://scn.sap.com/docs/DOC-8287
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides

Content Location on SAP Service Marketplace or in SAP Library

Information about Maintenance Planning Maintenance Planning Guide: See SAP Service Marketplace at

http://support.sap.com/mopz&l} section “Guides” ]

A.2 Description of Software Units

The following sections provide more details about product instances, standalone engines, optional standalone
units and clients of SAP NetWeaver.

Caution
Uninstalling additional product instances

Note that it is not possible to uninstall additional product instances and that this is also not supported by SAP.

1 Note
Usage Type, Technical Usage, and Product Instance

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.31 and higher. For more information, see SAP Note 1877731# . Note that there is no
terminology change for older releases and all mentioned terms can be used as synonyms.

A.2.1 Systems with Product Instances

Installation Options for SAP NetWeaver Systems With Product Instances

The standard SAP installation tool software provisioning manager 1.0 offersthe following options for
installing SAP NetWeaver systems with product instances:

e Application Server ABAP
This installation option installs an Application Server ABAP which is the basis for product instance BW ABAP
and Mobile.

® Process Integration
This installation option installs an ABAP+Java dual stack systems with product instance Process Integration
and all dependent product instances.

e Application Server Java
This installation option leads you to a selection screen where you can select those product instances that you
want to install in addition to Application Server Java and NW Product Description which are preselected.
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The following figure gives an overview of all available Java product instances and their dependencies:
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Figure 11: Java Product Instances

For more information and installation instructions regarding the additional product instances, see the
following documents:

o Installation Guide — Installation of Additional Product Instances on SAP Systems Based on SAP NetWeaver
7.3/ 7.3 EHPI1 Application Server Java. See in this guide the section Preparation for more information
about the dependencies for the product instances you want to install.

o SUM guide for Java: Update Guide — Updating SAP Systems Using Software Update Manager (for Java),
section Installing Additional Product Instances in an Existing SAP System

Apart from the product instances described here, there are some discontinued product instances that you
can still install for compatibility reasons. For more information, see Compatibility Product Instances [page
73].

Adobe Document Services (ADS)

Adobe Document Services is a set of runtime services that provide a range of form and document creation and
manipulation functions such as:

e Converting XML form templates (created using Adobe LiveCycle Designer) to PDF and various print formats

e Setting Adobe Reader rights to enable users to fill in and annotate forms, save and print them locally, and
include digital signatures for authentication using the free Adobe Reader software

e Extracting data from SAP applications into Interactive Forms and transferring form data back into SAP
applications using XML

Dependencies
Adobe document services depends on Application Server Java.

Functional Units
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Adobe Document Services comprises the identically named functional unit.
PDF Export

With PDF Export, you can create print versions of lists that are displayed using ALV for Web Dynpro for ABAP
(SAP List Viewer) and ALV for Web Dynpro for Java.

Dependencies
PDF Export depends on Adobe Document Services, Application Server Java and NW Product Description.
Application Server ABAP (AS ABAP)

AS ABAP serves as a development platform for the ABAP environment. SAP Business Suite is based on SAP
NetWeaver 7.0 and the features of AS ABAP included in SAP Business Suite 7i2010 and SAP NetWeaver 7.3 have
been aligned to a great extent. Although AS ABAP is fully supported as a development platform in SAP NetWeaver
7.3, we recommend using the enhancement packages for SAP NetWeaver 7.0 for ABAP development. For
information about the enhancement package availability, see SAP Service Marketplace at http://
support.sap.com/releasestrategy .

Application Server Java (BASIC)

AS Java is used to provide the Java foundation of SAP NetWeaver using the Java Engine, a Java EE-compliant
application server for running enterprise applications. In addition to the pure Java EE standard technologies, the
Java Engine implements complementary technologies such as Web Dynpro or Web Services.

Dependencies
AS Java can be combined optionally with other Java-based product instances in one system.
Functional Units

Application Server Java comprises the following functional units:

Table 17:
Functional Unit Description
CM Services (Change Management Services) CM Services help you to manage your Java development.

They provide services for creating development configura-
tions, for importing and exporting, and for the deployment to
runtime systems. CM Services enable you to set up team de-
velopment with centrally managed development configura-
tions. It also supports the automated deployment of build re-
sults on to central runtime system. The import and export
service enables you to import and export Software Compo-
nent Archives (SCAs) of a development configuration. When a
transport system is needed, a development configuration can
be integrated into the Change and Transport System (CTS+).
To use CM Services, product instance Dl is required.

Java Data Archiving Java Data Archiving provides APIs to allow Java applications

to connect to the XML Data Archiving Service for data archiv-
ing solutions. Java archiving is required for Java applications

with a large volume of retention-relevant data.
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Functional Unit Description

Java Foundation This is the Java foundation of SAP NetWeaver. Among its ca-
pabilities is the JEE Engine, a J2EE-compliant application
server for running enterprise applications. In addition to the
pure JEE standard technologies, the JEE Engine implements
complementary technologies, such as Web Dynpro or Web
Services, that are targeted at supporting large-scale, real-
business application development projects.

Services Registry The Services Registry is a registry for Web services. Located
centrally within an SOA landscape, it contains entries for all
services and service definitions in that landscape. The regis-
tered services are classified using semantic-rich classification
systems to enable the browsing of services by classification.

System Landscape Directory The System Landscape Directory (SLD) of SAP NetWeaver
serves as a central information repository for your system
landscape. A system landscape consists of hardware and soft-
ware components that depend on each other with regard to
installation, software updates, and demands on interfaces.
The information in the SLD is used by various SAP tools.

XML Data Archiving Service The XML Data Archiving Service (XML DAS) enables data to
be stored using the WebDAV Storage Interface for the ILM
Solution from SAP as certified in the interface BC-ILM. It al-
lows both XML-sensitive storage used for JAVA Archiving or
XML Archiving (see corresponding Functional units) and ILM
aware archiving used in SAP NetWeaver ILM.

Application Server Java Extensions (AS)

AS Java Extensions enable you to create development components in SAP-specific technologies on top of JEE, for
example, for service composition. In addition, you can enrich standard JEE technologies (such as Enterprise
JavaBeans, Web services, and enterprise applications) with additional SAP-specific capabilities, such as service
group configuration.

Dependencies

AS Java Extensions require AS Java and NW Product Description as a prerequisite in the same system.
Functional Units

AS Java Extensions do not comprise a functional unit.

Bl Java (BI)

Bl Java provides the Java runtime for several BW capabilities.

Dependencies

Bl Java requires AS Java, NW Product Description, Java Extensions, EP Core — Application Portal, and Enterprise
Portal in the same system. Usually, scenarios running on product instance Bl Java also require product instance
BW ABAP. While installing Bl Java, the required product instances are installed automatically. After configuring Bl
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Java, you do not need to perform further steps in AS Java, Java Extensions, EP Core — Application Portal, and
Enterprise Portal.

Functional Units

Bl Java comprises the identically named functional unit.

1 Note

Note that ABAP+Java dual stack systems and Java single stack systems are not supported with SAP HANA
database. For more information see the End-to-End Implementation Roadmap for SAP BW, powered by SAP

HANA on http://service.sap.com/instguidesnw73#% |l Planning 3.

Business Process Management and Business Rules Management

Business Process Management supports the process collaboration and creation of new innovative business
processes based on standardized core processes. SAP NetWeaver Business Process Management enables
collaborative composition of executable business processes based on a process model. Clearly defined business
rules can be incorporated into processes from the outset. The tight integration with Business Rules Management
enables business users with no coding skills to create and modify rules using decision tables.

With Business Rules Management you can author, execute, and manage business rules. The following key
features are offered by Business Rules Management:

e |nference-based rule engine implementing RETE algorithm

e Support of different rules formats (declarative rules, decision table and flow rules)

® Rules Manager: a Web Dynpro Java based rules maintenance tool for business users
e Versioning and tracking changes of business rules

e Qut-of-the-box Web service generation for rule sets

e Rules testing in the rules composer (NWDS)

e Public API for rules execution

e Tighter integration with Business Process Management

Dependencies

Business Process Management and Business Rule Management requires AS Java, NW Product Description,
Composition Environment Platform and Composite Application Framework in the same system.

Functional Units

Business Process Management and Business Rule Management comprise the following functional units:

Table 18:
Functional Unit Description
Process Server Contains the function for Business Process Management
Rules Server Contains the functions for Business Rules Management

Business Warehouse ABAP (BW ABAP)
Business Warehouse provides the infrastructure for the following functions:

e Datawarehousing
e Various analytical technologies and functions
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e Business planning functions

e \Web-based and Excel-based reporting, analysis, and planning

e [nformation broadcasting to distribute Bl content via various channels either as precalculated documents
with past data, or as links with live data

e Open analysis interfaces that make available various interfaces for connecting front-end tools of third-party
providers

Dependencies

BW requires AS ABAP as a prerequisite in the same system.

1 Note

For product instance BW, there is no installation option in the software provisioning manager 1.0.
Instead, you have to install AS ABAP with software provisioning manager 1.0 andthen SAP NetWeaver
7.03/7.31 Bl Content Add-On 7.46 or SAP NetWeaver 7.03/7.31 Bl Content Extensions Add-On 7.46 or higher.

1 Note
Note for SAP NetWeaver BW on SAP HANA database:

The SAP HANA database SP4 has to be pre-installed by certified hardware partners before the installation of
SAP NetWeaver. The installation accesses the SAP HANA database remotely to perform the necessary
database-specific installation steps. The installation includes Enhancement Package 1 for SAP NetWeaver BW
7.3 SPS3.

Note that only a standard installation and a distributed installation with a separate database server is
supported. Other applications must not be installed on the database server apart from the pre-installed SAP
HANA database and additional applications that it requires. This is because other applications may have a
negative affect on performance. This also includes parts of the distributed central instance (for example, an
application server must not be installed on the DB server).

For more information, see SAP Note 1600929 #r .

Central Process Scheduling by Redwood (JOB-SCHED)

SAP Central Process Scheduling adds powerful cross-component scheduling functionality to the integration
capabilities of SAP NetWeaver. SAP Central Process Scheduling has the following key characteristics:

e Centrality
There is only one central instance of this scheduler which takes control over all background processes in the
entire landscape and allows for cross system scheduling.

e Event-Driven Scheduling
Dependencies between background processes can be defined not only time based but also event based.

® Real-Time Execution
All information about jobs is stored centrally and transferred to the remote systems immediately before job
submission.

For more information, see SAP Developer Network at http://scn.sap.com/community/cps-by-redwood#.
Dependencies

SAP Central Process Scheduling requires Application Server Java and NW Product Description in the same
system.
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Functional Units

SAP Central Process Scheduling comprises the functional unit Integrated Central Process Scheduling by
Redwood.

Composite Application Framework (CE-APPS)

The Composite Application Framework is an abstraction layer that is used to develop all the components required
for the service and object layer of a composite application. These components are:

e Business Objects (Entity Services)

e Business Logic (Application Services)

e Connectivity to external services (Web Services and BAPI/RFC, local and remote persistency)
® Service Provisioning

The Composite Application Framework also provides a comprehensive toolbox that includes the following
features:

® A programming model

e Metadata

e Authorization concepts

e Modeling of relationships between business objects

® [ntegration into lifecycle management using SAP NetWeaver Development Infrastructure

This environment, which is based on a service-oriented architecture (SOA), enables developers to build
applications that leverage the whole SAP NetWeaver technology platform without the need to use low-level APIs.
This way, developers can focus on implementing the business logic of a composite application. The Service
Composer, a graphical modeling tool, provides service simplification and composition. This greatly eliminates the
need to write code for simplification and data mapping.

Dependencies

Composite Application Framework requires Application Server Java and NW Product Description in the same
system.

Functional Units

Composite Application Framework comprises the functional unit Composite Application Framework Runtime
providing the above-mentioned features.

Composition Environment Platform (CE-ENV)

The Composition Environment Platform provides a toolset and runtime for efficiently developing, running, and
managing composite applications based on SOA principles. It builds upon proven technologies that have been
enhanced and integrated to provide greater functionality and flexibility. The Composition Environment Platform
offers you the following capabilities:

e User interface (Ul) development: SAP NetWeaver Web Dynpro and SAP NetWeaver Visual Composer
Web Dynpro and Visual Composer are SAP's standard Ul technologies based on the Model View Controller
(MVC) for developing user interfaces. Web Dynpro Java or Visual Composer applications are developed within
the SAP NetWeaver Developer Studio using a model-driven approach that minimizes manual Ul coding and
uses visual tools to design and reuse components.

e Business Logic
The Composite Application Framework enables Java business object modeling.

e Service Simplification and Composition
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A graphical modeling capability simplifies and adapts Complex Services for easy consumption in Composition
Environment. This greatly eliminates the need to write code for simplification and data mapping.

Dependencies

Composition Environment Platform requires Application Server Java, NW Product Description, and Composite

Application Framework in the same system.

Functional Units

Composition Environment Platform comprises the following functional units:

Table 19:

Functional Unit

Composition Environment Platform

Description

Composition Environment Platform is the foundation for
building and running composite applications.

ECM integration core

Enterprise Content Management (ECM) Integration Core facil-
itates the provision and consumption of Enterprise Content
Management services using standardized interfaces. There-
fore, it enables business applications to consume core ECM
services provided by SAP as well as extended ECM services
provided by partners and third-party vendors leveraging their
ECM product offering. Besides the core runtime components,
this functional unit contains the service provider interface
(SPI) for exposing ECM services as well as the application pro-
gramming interface (API) for making use of these services.

ECM Integration Services

ECM Integration Services offer additional services on top of
ECM Integration Core functional. These supplementary serv-
ices such as the server for World Wide Web Distributed Au-
thoring and Versioning (WebDAV) can be leveraged by appli-
cations on top of the already exposed ECM services of the
connected service providers.

Visual Composer

Visual Composer is a model-driven development tool used to
create Ul screens and Portal content using a drag-and-drop
graphical environment, without the need to write code. Using
Visual Composer you can create standalone applications such
as form views and dashboards or Ul screens, such as Web
Dynpro screens. Visual Composer also provides Portal Con-
tent Modeling capabilities for generating Roles, Pages, iViews
and other content for the SAP NetWeaver Portal.

Portal Provides basic SAP NetWeaver Portal capabilities excluding
the Web Page Composer capabilities, the data statistics tools
of Portal Activity Reports, and the Activity Data Collector.
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Functional Unit

Description

Universal Worklist Offers users unified and centralized access to their work and
relevant information from within the portal. It collects tasks
and notifications from multiple provider systems — Business
Workflow, Collaboration Task, Alert Framework, and KM Re-
cent Notifications — and displays them in a single list.

Development Infrastructure (DI)

Development Infrastructure provides an infrastructure for developing Java-based applications on the SAP
NetWeaver platform and enables versioning of source code, build and lifecycle management of these applications.
Dl takes care of all parts of the development process :

1. Version control system for central management of source code: The Design Time Repository (DTR) is a
distributed version control system used in SAP NetWeaver Development Infrastructure to manage source
code in development and lifecycle management processes.

2. Central build and archive management: The Component Build Service (CBS), gives developers access to the
latest archive versions in a central archive storage and a central build triggered by developers or central
lifecycle management processes.

3. Central landscape and transport management: CM Services enables you to set up team development with
centrally managed development configurations. It also supports the automated deployment of build results
on a central runtime system. The import and export service allow you to import and export Software
Component Archives (SCAs) of a development configuration. If a transport system is needed, a development
configuration can be integrated into the enhanced Change and Transport System (CTS+).

You can also use the Change Management Service (CMS), which gives administrators a central service to set
up development landscapes for all development tasks and manage all transport processes for these tasks in
the same Ul. However, note that CMS is planned to be replaced by the CM Services in future releases.
Therefore, we recommend using CM Services.

Dependencies

e Dl requires AS Java and NW Product Description as a prerequisite in the same system. Optionally, it can be
combined with other product instances in one system. However, depending on the size of the development
project and the number of active developers, DI should use a dedicated system. For further details, see SAP
Note 737368 .

You can run the development infrastructure on an AS Java separately from the rest of your runtime systems
in the system landscape for improved scalability.

If you use a development infrastructure, you have to install the Developer Studio feature SAP NetWeaver
Developer Studio Development Infrastructure Client.

Functional Units

DI comprises the functional unit SAP NetWeaver Development Infrastructure providing the above-mentioned
functions.

Enterprise Portal (EP)

Enterprise Portal (EP) provides users with a single, uniform point of access to the applications, services, and
information they need for their daily work. Moreover, the Portal offers business users the features to easily create
and manage portal pages and generate their own content using the following capabilities:

e KM and Web Content Capabilities
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EP provides basic document management capabilities and content services within SAP NetWeaver Portal
(KM). KM provides the basic capabilities that customers need to run their scenarios, as well as an extension
framework for custom implementations.
These KM capabilities are also integrated into the Web Page Composer environment to enable flexible Web
content management scenarios, bringing relevant information from user-generated content and business
applications together in the portal.

e Portal Add-On with Forums and Wiki Capabilities
On top of EP, you can install the portal add-on including the forums and the wiki application.
The forums application provides a comprehensive range of discussion features, which are particularly
suitable for community scenarios. Forums typically focus on a specific purpose such as support or human
resources or they might offer customers a place to trade product tips and solutions. Intuitive user interfaces
make it easy for users to ask questions, share information, post announcements to the community, escalate
questions to experts, and to receive updates on posted comments. Users can create draft versions of their
postings, exchange private e-mails with other forum users, and vote in polls.
Wikis provide a framework to easily share and contribute knowledge and information in an intuitive way within
the company. They give employees, customers, suppliers, and partners a framework to collaborative writing,
and help save time by making ideas available, sharing knowledge, and managing related information.

Dependencies

EP requires EPC, AS Java, NW Product Description, and Java Extensions as a prerequisite in the same system.
Optionally, it can be combined with other product instances in one system.

Functional Units

Enterprise Portal comprises the following functional units:

Table 20:
Functional Unit Description
Knowledge Management Enables portal users to distribute, access, and manage un-

structured information within an organization in a heterogene-
ous repository landscape. Capabilities include collaborative
document authoring and publishing, version management,
search and navigation with taxonomies, automated classifica-
tion and subscription, and more.

Collaboration Brings users, information, and applications together to ensure
successful cooperation and interaction in the portal. These
tools include collaboration rooms, instant messaging, e-mail,

and calendar integration.

Enterprise Services Repository (ESR)

The Enterprise Services Repository (ES Repository) provides a central place where enterprise service definitions
are modeled, stored, and maintained. It supports SAP's concept of building services based on the process
component modeling methodology. The ES Repository offers the following features:

e Support of governed definitions of SOA assets (such as services and data types).

e Support of widely adopted open standards including Web Services and UDDI.
The ES Repository supports SAP-defined Global Data Types based on the Core Component Technical
Specification standards (stack) (CCTS standards (stack)).
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e Basis for enabling easy access to enterprise services - described with rich business classifications - when
developing composite applications and business processes.

Dependencies
Enterprise Services Repository requires Application Server Java in the same system.
Functional Units

Enterprise Services Repository comprises the identically named functional unit providing the above mentioned
capabilities.

EP Core — Application Portal (EPC)

EP Core — Application Portal (EPC) provides the basic portal capabilities for SAP NetWeaver. It provides a uniform
entry point to content and applications in a consistent, role based manner. It offers a single point of access
through a Web front end to SAP and non-SAP information sources, enterprise applications, information
repositories, databases and services across organizational and technical boundaries — all integrated into a single
user experience. EPC alone provides more flexibility when implementing a portal where the full enterprise portal
capabilities (such as knowledge management tools) are not needed.

The EPC product instance contains some additional important capabilities that will help you manage your content
and processes:

e The core portal capabilities include various tools and service for managing portal content, users, and
connections to connected systems such as Single-Sign-On, tools for application integration, roles and
permissions, changing the portal look and feel with the new Ajax Framework, and lifecycle management
(transport).

® Integration of several SAP NetWeaver Portals and third-party portals into one harmonized SAP NetWeaver
Portal acting as the single point of access to all the business related applications and services in the
organization.

e \Web Page Composer (WPC): this is an integral part of EPC providing powerful capabilities for business users
to easily create and manage enriched portal pages. Web Page Composer supports professionals creating
interactive portal pages.

Dependencies
EPC requires AS Java and NW Product Description as a prerequisite in the same system.
Functional Units

EP Core — Application Portal comprises the following functional units:

Table 21:
Functional Unit Description
Portal Provides basic SAP NetWeaver Portal capabilities
Universal Worklist Provides the Universal Worklist Capabilities

Mobile

Product instance Mobile is used to enable field personnel to participate in a business process in an “occasionally
connected” mode. Occasionally connected means that a direct connection (using WLAN or GPRS) between the
mobile device and back end is only established at certain times — at synchronization points, when the Mobile
Server (that is, the system with product instance Mobile) and Mobile Client exchange data in order to keep the
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server and client updated. This enables the user to perform process tasks completely independently from the
back-end system, which is extremely helpful if a steady connection cannot be guaranteed or might be too
expensive. To realize this product instance, an intelligent application needs to run on each device containing a
user interface, business logic, and data handling. Mobile includes the Data Orchestration Engine (DOE), an ABAP-
based message-oriented middleware. The Data Orchestration Engine consists of the following:

e Adesign time tool for defining data objects and the distribution of data.

e Aruntime to replicate, synchronize and distribute data between the components of the system landscape.
This includes, for example, messaging, filling queues, and sending data to the back end.

Dependencies

Mobile is not an installable software unit. As of SAP enhancement package 1 for SAP NetWeaver 7.3, SAP
NetWeaver Mobile is available as add-on. To set up a Mobile system, you install and configure AS ABAP. On top of
the AS ABAP system, you install and configure the SAP NetWeaver Mobile add-on separately.

NW Product Description (NW-MODEL)

NW Product Description contains metadata for SAP NetWeaver, for example, about comprised software
components and their interdependencies. NW Product Description is always included when you install a Java
product instance.

Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Pl requires AS ABAP, AS Java, NW Product Description, AS Java Extensions, Pl Adapter Engine, and Enterprise
Services Repository as a prerequisite in the same system.

For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated PI system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units
Process Integration comprises the functional unit SAP NetWeaver Process Integration.
Restrictions for Systems with Multiple Product Instances

e |f you have one system with multiple product instances, be aware that we do not provide standard tools for
separating these product instances and distribute them to multiple systems at a later stage. For example, if
you have a system with product instances A and B, you are not able to migrate it with SAP standard tools into
two systems, one with product instance A only and the other with product instance B only.

In addition, we do not provide standard tools for merging multiple systems with different product instances
into one system with multiple product instances at a later stage. If you want to perform these tasks, you
require specific project support. The only exception is the dual-stack split procedure that offers to split an
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optional dual-stack system into two separate systems, one based on AS ABAP, the other one based on AS
Java. For more information about the dual-stack split, see http://scn.sap.com/docs/DOC-25162 # .

The following figures shows that SAP standard system copy and migration tools do not support you in
separating or merging systems with product instances:

Figure 12: Separating systems with product instances are not supported with SAP standard system copy and migration
tools

Figure 13: Merging systems with product instances are not supported with SAP standard system copy and migration tools

e Although you can use one system for multiple product instances, client restrictions apply to product instance

BW ABAP. For BW ABAP, you should reserve a dedicated client for reporting purposes. In this client, activate
the SAP NetWeaver Bl Content Add-On as required.

A.2.2 Optional Standalone Units

Advanced Adapter Engine (Pl Adapter Engine)

You use the Advanced Adapter Engine to connect to SAP systems (RFC adapter, IDoc Adapter, and ABAP
proxies) and external systems. You use the various adapters in Pl Adapter Engine to convert XML- and HTTP-
based messages to the specific protocol and format required by these systems, and the other way around.
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You can use the following adapters:

e RFC Adapter

e SAP Business Connector Adapter

e File/FTP Adapter

e JDBC Adapter

e JMS Adapter

e SOAP Adapter

e Marketplace Adapter

e Mail Adapter

e RNIF Adapter

e CDIX Adapter

® |Doc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
e HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)

You can use the Advanced Adapter Engine which is included in the Pl system as a central adapter engine.
Optionally, for performance reasons, you can install a non-central Advanced Adapter Engine on a separate host.

Dependencies

The Advanced Adapter Engine requires AS Java, NW Product Description, and AS Java Extensions as a
prerequisite in the same system. These product instances are automatically installed when you install the
Advanced Adapter Engine.

Functional Units
The Advanced Adapter Engine comprises the functional unit Advanced Adapter Engine.
Advanced Adapter Engine Extended

The installation option Advanced Adapter Engine Extended (AEX) consists of core components to model, design,
automate, and integrate processes in one or more application systems. The Advanced Adapter Engine Extended
provides the following capabilities:

e (Connectivity capabilities of the Advanced Adapter Engine (AAE)

e Design and configuration tools to set up scenarios that are based on the AAE. In particular, for design and
configuration you can use the ES Repository and the Integration Directory. The Integration Directory installed
with AEX contains a subset of configuration options required for the configuration of message processing by
the AAE, basically the integrated configuration.

e Mediation capabilities of AAE
You can use the following adapters:

o RFC Adapter

o  SAP Business Connector Adapter
o File/FTP Adapter

o JDBC Adapter

o JMS Adapter

o SOAP Adapter

o Marketplace Adapter

©o  Mail Adapter

o RNIF Adapter

o CDIX Adapter

o |IDoc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
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o HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)
Dependencies

Advanced Adapter Engine Extended requires AS Java, NW Product Description AS Java Extensions, Pl Adapter
Engine, and Enterprise Services Repository as a prerequisite in the same system.

These product instances are automatically installed when you choose the installation option Advanced Adapter
Engine Extended.

Functional Units
Advanced Adapter Engine Extended comprises the identically named functional unit.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Pl requires AS ABAP, AS Java, NW Product Description, AS Java Extensions, Pl Adapter Engine, and Enterprise
Services Repository as a prerequisite in the same system.

For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated Pl system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units

Process Integration comprises the functional unit SAP NetWeaver Process Integration.

A.2.3 Standalone Engines

For SAP NetWeaver, the following standalone engines are available:
Adapter Engine Java SE

Adapter Engine (Java SE) is a separate software unit. You can use it only if you have SAP NetWeaver systems with
product instance Pl in your system landscape. It has to be installed manually. You use the Adapter Engine (Java
SE) to connect to external systems. Using the various adapters in the Adapter Engine (Java SE), XML and HTTP-
based messages can be converted to the specific protocol and format required by such systems, and the other
way around. The Adapter Engine (Java SE) only provides some of these adapters as a standalone version with
restricted functions for operating systems that do not support SAP NetWeaver PI, but that have at least a Java
Runtime Environment 5.0. Therefore, you should use the Adapter Engine (Java SE) only if the platform
prerequisites do not allow you to use the Advanced Adapter Engine.

Content Server
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Content Server is a separate server instance that is used to store documents or other types of content related to
SAP applications. The accompanying cache server can cache content if your company operates in several
locations. This reduces load on the wide area network when working with documents.

liveCache

liveCache is a database engine for managing complex objects in scenarios where large volumes of data must be
permanently available and modifiable.

Search and Classification (TREX)

SAP NetWeaver Search and Classification (TREX) offers an integrated set of services. TREX services include
search and retrieval in large document collections, text mining, automatic document classification, and search
and aggregation over structured data in SAP applications. TREX can handle text from documents in numerous
formats, including Microsoft Office and Adobe formats (PDF), and more than 30 languages. TREX search options,
such as exact, Boolean, fuzzy, or linguistic search, and classification options such as query-based or example-
based classification, offer great power and flexibility to end users.

The BW accelerator is based on TREX technology. You need an installation based on 64-bit architecture for the
BW accelerator. The hardware partners provide this variant already preconfigured as the BW accelerator box.
Note that a TREX installation configured for searching in metadata and documents based on 32-bit architecture
cannot be used for the BW accelerator. Accordingly, a BW accelerator box also cannot be used for searching in
metadata and documents. In order to be able to use the search function and the BW accelerator, you need
separate installations.

Web Dispatcher

The Web Dispatcher lies between the Internet and your SAP system. It is the entry point for HTTP(s) requests into
your system, which consists of one or more SAP NetWeaver application servers. As a software Web switch, the
Web dispatcher can reject connections or accept them. When it accepts a connection, it balances the load to
ensure even distribution across the servers.

You can use the Web dispatcher in ABAP/Java systems and in pure Java systems, as well as in pure ABAP
systems.

Itis also beneficial to use the Web Dispatcher if you do not need security functions (entry point in the demilitarized
zone (DMZ), SSL, URL filtering), but you simply want to balance the load between multiple SAP NetWeaver
Application Server instances.

Since Web Dispatcher is optional for every SAP system, it is not contained in the system landscapes of the use
cases in this documentation.

For more information, see the SAP Library at http://help.sap.com/nw731#& |+ Application Help » SAP NetWeaver
Library: Function-Oriented View » Application Server » Application Server Infrastructure » SAP Web Dispatcher .

A.2.4 Clients

With SAP NetWeaver, you can use the front-end clients and tools described below:
Adobe LiveCycle Designer

Adobe LiveCycle Designer enables the creation of forms that combine high-fidelity presentation with XML data
handling. The easy-to-use graphical interface of Adobe LiveCycle Designer enables users to quickly design forms,
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maintain form templates, define a form's business logic, make changes, and preview forms before they are
deployed as Adobe PDF files.

SAP NetWeaver Business Client

The SAP NetWeaver Business Client (NWBC) is a high fidelity desktop client that allows users to display their
assigned roles and to launch applications. SAP NetWeaver Business Client offers a unified environment for and a
single point of entry to SAP business applications and technologies. NWBC is ideal for displaying business
applications such as classical SAP GUI Uls, Web Dynpro Uls, BSP pages, and other content using its multiple
rendering engines. NWBC provides role-based access to applications either via the portal or directly using PFCG
roles. In addition to the basic capabilities detailed above, the SAP NetWeaver Business Client makes use of its
tight desktop integration to provide additional benefits such as desktop search functionality. In the newest SAP
NetWeaver Business Client version you will find the improved user interface (Ul) based on the SAP Signature
design. This Ul offers in part an expert-based interactive paradigm and a superior look and feel matching the
expectations of today's users aiming to maximize their daily activities.

The SAP NetWeaver Business Client is one of the main components of the User Interface Add-On for SAP

NetWeaver. For more information, see the SAP Help Portal at http://help.sap.com/nw-uiaddon®|» Application
Help 3.
Business Explorer (Bl Add-On/BW Add-On)

Business Explorer provides flexible reporting and analysis tools for strategic analyses and decision-making
support within a company. These tools include query, reporting, and analysis functions. As an employee with
access authorization, you can evaluate past or current data on various levels of detail and from different
perspectives, not only on the Web but also in Microsoft Excel.

You can use Business Explorer Information Broadcasting to distribute Business Intelligence content by e-mail
either as precalculated documents with historical data, or as links with live data. You can also publish it to the SAP
NetWeaver Portal.

Additionally to Business Explorer you may want to consider using tools from the SAP BusinessObjects Analysis
family, such as Analysis, edition for Microsoft Office. The SAP BusinessObjects Analysis clients are specifically
designed for the needs of BW users. Note that SAP BusinessObjects products require separate licenses

SAP GUI

SAP offers three different client applications for accessing ABAP applications in SAP systems (such as SAP
NetWeaver systems with product instance AS ABAP). This SAP GUI family consists of:

e SAP GUI for HTML
SAP GUI for HTML is based on the SAP integrated Internet Transaction Server (ITS) which is included in the
installation of SAP NetWeaver systems as of SAP NetWeaver 7.0. On the client side, only a suitable browser
and a virtual machine are required. For information about supported browser versions, see the Product
Availability Matrix at http://support.sap.com/pam .

e SAP GUI for the Java environment (SAP GUI for Java)
SAP GUI for Java is a generic SAP GUI that covers a variety of platforms.
For more information about the installation of SAP GUI for Java, see the documentation Installation Guide —
SAP Front End.

e SAP GUI for the Windows environment (SAP GUI for Windows)
SAP GUI for Windows is SAP's universal client for accessing all SAP applications built on ABAP technology. It
is available on the Microsoft Windows platform only and offers the broadest feature set of all members of the
SAP GUI family.
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For more information about the installation of SAP GUI for Windows, see the Installation Guide — SAP Front
End.

SAP GUI also includes optional add-ons, such as the BW add-on and KW add-on, which might be required to use
certain SAP NetWeaver capabilities.

1 Note

Data warehousing: SAP GUI for HTML and SAP GUI for Java do not have all the capabilities of SAP GUI for
Windows. BEx Query Designer, BEx Analyzer and Uls with network controls are not supported with SAP GUI for
HTML and SAP GUI for Java.

The following SAP GUI versions are supported with SAP enhancement package 1 for SAP NetWeaver 7.3:

e SAP GUI for Windows 7.20 (or higher)
e SAP GUI for Java 7.20 (or higher)
o SAPintegrated ITS

For more information about the SAP GUI family, see SAP Community Network at http://scn.sap.com/
community/guif.

Mobile Client

Mobile Client is installed locally on mobile devices, and is equipped with a Web server, a database layer, and a
framework for the mobile applications. Staff working remotely can therefore work offline and do not have to wait
for a network connection to complete time-critical business applications. Product instance Mobile offers tools for
synchronization and data replication that make the data of the mobile device consistent with that of the back-end
system.

SAP NetWeaver Developer Studio

The SAP NetWeaver Developer Studio is SAP’s Integrated Development Environment (IDE) for Java and is based
on the open-source tools framework Eclipse 3.3. With the SAP NetWeaver Developer Studio, you can develop Java
EE 5 applications from scratch using the built-in support for new technologies such as EJB 3.0 and JSF 1.2.

SAP Enterprise Services Explorer Tool for Microsoft .NET

As part of its service-oriented architecture (SOA) offering, SAP provides a set of consumer tools that allow the
discovery and consumption of enterprise services from various development environments, such as NetWeaver
Developer Studio, Visual Composer, and Microsoft Visual Studio. SAP Enterprise Services Explorer tool for
Microsoft .NET (ES Explorer for .NET) is an add-on for Microsoft Visual Studio 2005 and Microsoft Visual Studio
2008 that helps to leverage SOA by enabling .NET developers to discover SAP enterprise services and consume
them in their applications, as well as publish their own custom services. It is an important element of SAP -
Microsoft interoperability.

To download the tool, access documentation and other resources, see http://scn.sap.com/community/
interoperability/microsoft-net .

For the most up-to-date information about ES Explorer for .NET, see SAP note 1259258 #r .
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A.3 Compatibility Product Instances

Compatibility product instances are product instances that have been discontinued and are therefore not part of
the standard SAP NetWeaver installation. If you upgrade from a previous release, these product instances will of
course still exist in your systems if they have been present in the source release system.

There might be reasons for which you want to install these product instances. You can do this using the Java
Support Package Manager. Note that you can install these product instances only on existing SAP enhancement
package 1 for SAP NetWeaver 7.3 Java systems with at least product instance AS Java.

For more information and installation instructions, see the following documents:

e [nstallation Guide — Installation of Additional Product Instances on SAP Systems Based on SAP NetWeaver
7.3/ 7.3 EHPI Application Server Java. See in this guide the section Preparation for more information about
the dependencies for the product instances you want to install.

e SUM guide for Java: Update Guide — Updating SAP Systems Using Software Update Manager (for Java),
section Installing Additional Product Instances in an Existing SAP System

Composition Voice

With Composition Voice you can design, develop and run interactive voice response (IVR) applications which can
be accessed using telephones. Voice recognition and keypad input from telephone is used as input and recorded
messages or computer generated speech (text to speech (TTS)) is used as output. Composite Voice provides
system access to users with telephones at anytime from anywhere. Business transactions become easy to use
with paperless transactions. It limits dependency on mobile devices, computers and Internet access, and helps
businesses to reach users large scale while saving costs.

Dependencies

Composition Voice requires Application Server Java, Composition Environment Platform, and Composite
Application Framework in the same system.

Functional Units

Composition Voice comprises the following functional units:

Table 22:
Functional Unit Description
Composite Voice Design Time Design time for Composite Voice
Composite Voice Runtime Runtime for Composite Voice

Demo Applications

Demo Applications illustrate the usage of SAP NetWeaver Composition Environment for previous releases.

SAP NetWeaver Master Guide
Appendix PUBLIC 73



Guided Procedures

Guided Procedures is a framework for modeling and managing workflows using simple and user-friendly tools.
Guided Procedures enables access to multiple backend systems, consistently combining different types of
services and applications into processes. In addition, Guided Procedures supports collaboration, ad-hoc items,
and offline task management using interactive forms. It provides role-based access to tools and resources and
guidance through the workflows at runtime, thereby helping end users to easily identify and complete their tasks.

Dependencies

Guided Procedures require Application Server Java, Composition Application Framework, Composition
Environment Platform as a prerequisite in the same system.

Functional Units

Guided Procedures comprise the identically named functional unit providing the above mentioned capabilities.

NWDS Update Site

You use the NWDS update site when you develop composite applications using several Developer Studio
installations. An update site contains all features for the Developer Studio. You can initiate a check for updates or
additional features in the Developer Studio and install them when available. The update site capability mirrors the
SAP Developer Studio update site on SAP Service Marketplace for an improved update performance. It does not
run on a multi-node cluster.

The NWDS update site has been replaced by an Eclipse-based solution.
Dependencies

NWDS update site requires Application Server Java as a prerequisite in the same system.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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